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n the October issue of this journal,

we had a small error; John Bland’s

fine article entitled “A Little OOP, CF

Style” ended up with the classification of

Flash ActionScript. Unfortunately it was

not caught until the edition was in print.

However, when I reviewed the article, I

was struck by the fact that many of the

OOP concepts John discussed, while put-

ting them in a ColdFusion context, were

equally applicable to ActionScript. As a

matter of fact, John makes allusions to

that very point. 

As all of our technologies advance, it

is getting harder to differentiate between

them. ActionScript is very close, in syntax,

to Java; which is very close to the C++

language. We will soon see ColdFusion

looking more like ActionScript/Java/C++. 

As these technologies grow closer,

the ability to seamlessly merge them will

also become easier. We already see Flash

serving as the graphical user interface to

Java applications, lessening the need for

the Java applet. What could be more

ideal than delivering the power of Java

with the low-bandwidth flexibility of

Flash? Macromedia’s new product, Flex, is

certainly taking us in the direction of

merging divergent technology. 

As industry professionals, we face a

number of challenges for the future. First,

we must accept that the old categories are

quickly eroding away. To be serious devel-

opers, we need to have knowledge of mul-

tiple technologies. In my opinion, knowl-

edge of Flash ActionScript 2.0 demands

knowledge of Java. Second, we must real-

ize that the distinction between designer

and developer is slowly going away.

Increasingly, graphics people must know

some programming, and programmers

must understand graphic concepts. Rest

assured that for many the learning curve is

going to be long and hard. But, in my opin-

ion, this future is now carved in stone. 

In September, I had the pleasure of

speaking at the MXimize conference in

Boston. Here we saw workshops for these

seemingly divergent technologies. I

delivered workshops on CSS, Dream-

weaver Behaviors, and moving away from

the Flash Timeline. Tom Green spoke

about Flash Video while Joseph Lowrey

and Art Phillips spoke about RAD (Art’s

series on RAD started in MXDJ October as

well). Our own Dave McFarland,

Dreamwearver section editor, spoke

about Dreamweaver design concepts. 

Conferences such as this, and the

MAX conference just held, are important.

I find that the interaction of the partici-

pants can be a shot of adrenalin. I was

amazed at how many people, who had

never met each other before, were

exchanging business cards and network-

ing with each other. 

We will be repeating this conference

in Orlando, Florida, December 14–16. I

sincerely hope I will see many of you

there (www.mximizeconference.com).

With all of these technologies coming

together, education is going to be a

major factor. As industry professionals,

we must work constantly to update our

skills to keep them fresh and marketable.

In addition, training needs to be deliv-

ered to the end users of the products we

are developing. Programs such as

RoboDemo 5.0 are making major strides

in delivering this needed training in a

cost-efficient manner. 

By the time you receive this issue, a

new version of RoboDemo will be avail-

able. Not only will it have a new look and

feel, but it will have a new name:

Captivate. This product will have the abili-

ty to tightly integrate with Flash. Once

again, we are seeing technologies merg-

ing. In my opinion, this is going to be a

major topic within the e-learning com-

munity. In that light, we will develop a

new section devoted to Captivate, head-

ed by noted author Tom Green. Tom has

already shown me some fascinating uses

for this newly updated technology -- in

fact, this issue of MXDJ has a review of

Captivate. 

Next month, I'll discuss the exciting

plans we have for MXDJ in 2005. 
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Technologies moving together – not apart
by charles e. brown
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harles Brown’s editorial last

month brought praise and dis-

cussion. These are just a few of

the comments we received -- and some

of his answers.

I agree that Flash is the technology that

will take over the Web, but how will MM

overcome the search engine issues that

currently keep e-Comm sites from using

Flash on their sites? I develop for Flash as

well as e-Commerce, but rarely the both

in the same project. E-commerce people

always say they don't want to use Flash

because of the lack of recognition by the

search spiders.

john rossey

It was refreshing to read “A Move to

the Future” in answer to the question of

where we are going. I look forward to

each month with anticipation. And I

would also like to congratulate you on

writing something worth reading.

josh utley

I disagree; my use of the Web is for

information, not Flash. I find the sites

with Flash are slow to load; while I wait

to see if there is worthwhile data, I am

losing time looking for data that can

improve the health of my patients or

slow down the students in my classes

looking for better information . When I

go to commercial sites using Flash the

pictures get in the way of information.

Flash is nothing but hype! All emotion,

no reality.

kim buttery

I am sure Macromedia would like this

very much to happen.

As I looked around when I read your

article, I couldn't really find a lot of full

Flash–based Web sites or tools that

would help me create standardized and

exchangeable tools to create these sites.

As a Web designer/developer, I don’t

have a lot of requests from customers

for Flash (only the intros and banner

stuff ). I think the hype is within the

industry itself, but not the

customer/client side. I think IBM knows

where we’re going, but you will hear

about this soon.

marcellino bommezijn

I have to add a comment in response to

what Kim said: While it is true that there is

a bunch of Flash out there that detracts

from the Web site content, that is not

how it has to be. Carefully designed Flash

can be very, very quick to load. If the full

capabilities of Flash are implemented, it

Developing Databases

Charles,

I appreciated your fresh, forward-looking insights in your

article about Flash.  I'm a new Web developer who has

embraced Macromedia almost exclusively. I have heretofore

shunned other companies' programs (e.g., Adobe) in order to

maximize the journey up the learning curve and to take

advantage of synergies and compatabilities between the pro-

grams in the suite of MX 2004 products.

I love that you are going to start next time with

ActionScript 2.0 tidbits! I have just learned how to use levels

to launch various Flash files from a main Flash file. Nice, mod-

ular, clean!

I do have a question: My middleware of choice is, of

course, CF. My question is whether you think (even from a for-

ward-looking perspective) that in general we should develop

dynamic, database-driven (e.g., MySQL) Web sites as Hybrids

(pull data from CF in HTML) and attach/insert Flash movies

separately within an HTML table. OR

Do you believe that we should develop dynamic, data-

base driven sites entirely in Flash? I know that the latter is pos-

sible via Flash remoting, but I have been counseled by some

Flash experts to do the hybrid approach (which appears to be

quite a bit easier).

Do you see the hybrid approach going away? Should we

migrate to using just Flash? If Web site search engine opti-

mization is not important, should we migrate to using just

Flash? Or is the hybrid approach OK in your opinion?

jim

Charles Brown’s answer

Every situation presents its own requirements. There is no

one answer that will fit all situations. I always tell beginning

Web developers to “know your audience.”

As an example, I did a Flash site for a symphony orchestra.

We subsequently discovered that a high percentage of the

intended audience had older machines and slower connec-

tions. As a result, we had to recast the site to HTML. For most

sites, a hybrid is usually the way to go. However, as I said last

month, plan for the future when designing it.

Beginning in the December issue, I will be starting an

ActionScript series that will look at it from the beginning.
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can be faster than HTML regardless of

bandwidth. I have developed .swf's for

sites that weigh less than 1.5k. Yes that's

right. Many of the .swf's I have put on

Web sites actually appear first on the

loading of the page. Poorly built Flash is

slow and cumbersome, but that is poor

design, not the fault of Flash. It is vital

that these misconceptions be destroyed

so that Flash can flourish as it deserves to.

What other Web technology is capable of

doing almost anything you can imagine?

Only Flash.

john rossey

I agree with Marcellino Bommezijn –

the Flash hype is within the industry.

Clients normally do not understand the

difference between HTML, ASP.NET and

Flash. However, it is our responsibility as

designers and developers to educate

them.

I completely disagree with Kim

Buttery's opinion. She must be looking at

sites that were created in Flash 4 – 1998

technology. Since the release of Flash 5

and Flash Generator, developers have

been able to build fast-loading database

driven information based sites. Over the

past 3 years we have seen a huge success

in database integration with the release

of Flash MX and then Flash MX 2004 with

Action Script 2.0.

In regards to the comment on down-

load time, Flash is not to blame. That

argument also holds true for HTML sites

that have large 100k JPEG images or sites

that have 1 image sliced into 20 images.

The download time has everything to do

with how the developer/designer builds

the site.

The only thing I have left to say is

this... Flash is currently the best tool to

build intuitive dynamic Web sites. But like

HTML, Flash will one day be replaced by

another great technology and as Web

developers we should embrace these

new technologies. Hopefully the next

new technology will allow search engines

to index Flash content. :o)

dave

First let me say that I really like Flash.

I like being able to use fonts and control

layout with complete confidence that it

won't look goofy in some browser.

However, to say that the industry is

going to Flash is simply an overstate-

ment.

As someone else mentioned, there

are problems for Flash-based sites as it

relates to search engines and more

importantly accessibility. HTML-based

sites are often terrible in their support of

accessibility, but with the adoption of

CSS and education, this is improving dra-

matically. Flash has been inaccessible for

people who rely on assistive technolo-

gies. However, the newest versions of

Flash now allow for support of assistive

devices like screen readers, but again it

will require education of designers/devel-

opers to take advantage of these new

features. Which leads to my fundamental

problem with adoption of Flash on such a

wide scale... versions.

The main benefit for using Flash was

to dispense with the tedious task of writ-

ing code/HTML for x, y, z platforms and a,

b, and c browsers. While Flash is not

affected greatly by the platform issue, we

now have versions of Flash which do not

support some of the nifty (and essential)

new features. And now we have to do

not just Flash detection, but Flash version

detection.

jim lofton

I just worked on a project where I

wanted to use styles with XML content

displayed in a Flash interface. At first I

saved it to be backward compatible with

older Flash players... and then I noticed

that the styles did not get applied... Yes,

users can be prompted to upgrade their

player. But as they say in retail/e-com-

merce, every step between the customer

and the purchase of your products is yet

another hurdle or barrier the customer

may not jump.

So while it is great to see Flash

address some of its earlier shortcomings

(which I would think that the accessibility

features can also be used to address the

search engine problem), it introduces

another problem or more accurately, suf-

fers some inherent problems of deliver-

ing content to a client – a client not

maintained or controlled by you. I look

forward to using Flash in any project I

can, but it is still going to be limited by

what the projects requirements are and

not what I want to do.

In my opinion, client-side technolo-

gies, such as HTML and related scripts,

have run their course and are relics of a

past state of technological evolution. ”...Is

Flash no longer a client-side technolo-

gy?”

nick

Actually, since Flash can interact with

XML so well, it is not really a client-side

technology in the sense that HTML is.

HTML is limited to what you can “strap-

on” whereas Flash is ready to interact

with anything from databases to ASP

scripts through XML and therefore is as

much a server-side solution as ASP.NET.

At least that's how I feel about it. Let's not

forget the fact that Flash is the same in

every browser that supports it. I can't

think of any other language or technolo-

gy that behaves the same no matter

which platform the user is on.

john rossey
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Marketing Flash

As a Flash developer who has worked with the program

for over half a decade, I totally agree with your article. Flash

certainly is the optimal solution for data integration. It is just

unfortunate that the popular search engines tend to have a

“blindspot” for all-Flash applications.

Anyway, to the million-dollar question…

What have you found to be the best approach to mar-

keting your Flash data integration services to potential

clients?

Our company has had great success, from a technical

standpoint at least, with developing Flash RIAs that inte-

grate dynamic data via Web services. The challenge seems

to be convincing companies that they should update their

sites to this technology, or at least incorporate Flash RIAs

where applicable.

Can you recommend any approaches that have been

successful for your company?

scott

Charles Brown’s answer

Right after the article came out, I got hit with a ton of 

e-mail asking about the search engine issue.

There are several ways around this. First of all, you could

embed the search engine tags within the calling HTML

page. Second, Macromedia has a search engine SDK for

Flash at www.macromedia.com/support/flash/ts/docu-

ments/search_engines.htm>http://www.macromedia.com/s

upport/flash/ts/documents/search_engines.htm

I have not had the opportunity to test it with MX 2004

Professional. However if someone wants to test it, or any

potential third-party software, and write an article, it would

be happily received (hint…hint…hint).
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s an educator with a post-sec-

ondary institution I have had

something of a ringside seat

watching the evolution of e-Learning. My

biggest complaint was that, in general,

most institutions getting into the game

just “didn’t get it.”Their approach to the

process was to create what I called “digi-

tal in-baskets” where the student com-

pleted the work and sent it in as an e-

mail attachment. How they could regard

this process as “distance learning” or the

“digital classroom” was a mystery to me.

One institution proudly walked me

through their “digital in-basket” and was

quite upset when I suggested they could

save themselves some serious infrastruc-

ture dollars by replacing the program

with something more efficient: envelopes

and stamps.

Things changed for me this spring. I

was talking to my Dean about instituting

an e-Learning program at my college and

there was no discussion of “in baskets”.

The rationale actually made sense. The

college, looking to expand its reach, real-

ized it was running out of parking lots for

new buildings and that maybe the col-

lege should go to the students rather

than the students come to the college. At

about the same time, this discussion was

going on, Peachpit Press asked if I would

be interested in writing the RoboDemo

Visual QuickStart. Right in the middle of

that project, Macromedia unveiled the

beta of RoboDemo’s replacement,

Captivate, and it was at that point that I

realized e-Learning had become serious

business and Macromedia was, as is so

typical of the company, in the vanguard

of an evolving discipline.

It Does Almost Everything
Captivate has all the hallmarks of

becoming an important Macromedia

product. If you are looking at doing any

sort of e-Learning either in the private or

public sectors, Captivate will most likely

become your most important course

development and support tool. What fol-

lows is an overview of the major features

of the product. 

First, if you are a longtime RoboDemo

user understand this: “RoboDemo is

dead. Get over it.” What Macromedia has

managed to do is to successfully retain all

that was good about RoboDemo and

then seriously improve on it by either

Captured by Captivate

Feature rich and a lot of fun
by tom green
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beefing up the feature or replac-

ing it with something even

better. In fact, it starts as

soon as you open the

application.

When Captivate

launches you arrive in a

very familiar place: a

typical Macromedia

Start Page that replaces

RoboDemo’s Project

View panel. Here you can

open new documents,

create new recordings, open

other types of movies, and

even work your way through a

few tutorials. A rather nifty feature of

this page is the ability to keep the page

manageable. If you right-click on the

name of a recent movie, you are given

the opportunity to open the movie, hide

the movie, or even delete it from the

Start Page. If you are a RoboDemo user

your movies are still compatible with

Captivate. If you open a RoboDemo

movie in Captivate, the movie is convert-

ed to the Captivate format, including the

replacement of the .RD extension with

the new .cpt file extension (see Figure 1).

When a movie opens you will experi-

ence another great change.  The

RoboDemo Frames and Edit View Panels

have been replaced with panels named

Storyboard and Edit. In fact, the term

“frames” is defunct. It has been replaced

with the more succinct term “slide”.

Figure 2 shows you the differences

between the Frames View panel in

RoboDemo and Captivate’s new

Slideshow View panel.

The two biggest changes are the

addition of “Record” and “Publish” buttons

to the Main toolbar. Click the Record but-

ton and Captivate will ask you where the

new recording will be placed in the cur-

rently open movie (see Figure 3). Click

the Publish button and you have one

click access to a number of new and old

output options (see Figure 2). The term

“publish” replaces the term “export” in

RoboDemo and moves Captivate’s termi-

nology into line with the rest of

Macromedia’s products.

The Edit View panel is another area

where there have been some major

changes. The first one you'll notice is the

addition of a timeline and a change in the

Advanced Toolbar that reflects many of the

changes in the application (see Figure 4).

The timeline is probably the single

most important addition to the product.

One of my biggest complaints with

RoboDemo was an inability to control the

timing and duration of objects in a frame

and even the frame itself. This has all

changed. If you are a Flash or Director

user, the biggest mistake you can make is

to view the Captivate timeline as being

similar to the ones in those two applica-

tions. A good way of looking at the time-

line in Captivate is to regard it as a micro

view of each frame in a Flash or Director

movie. Objects on the timeline can be

dragged to new positions on the timeline.

You can expand or contract their duration
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by dragging the edge inwards or out-

wards and, if you're a control freak like

me, double-click any object on the time-

line and you can set its appearance and

duration in the slide “by the numbers”

(see Figure 5). Double-clicking a timeline

object opens the Object’s properties dia-

log box where the object can be edited.

Even the recording process has

undergone a fundamental change … for

the better. Macromedia spends an inordi-

nate amount of time listening to its users

and the changes to the recording process

reflect how users approach the end use

of the product. There are three types of

recordings you can create. They are:

• Demonstration: A typical “sit -back-

and-watch-how-it-is-done” presenta-

tion

• Simulation: Simulates how the prod-

uct is used and requires the viewer to

be engaged in the process

• Training: The student is essentially told,

“You have seen the demo and you have

seen how to use it. Now you try it.”

These modes are now available to you

right in the Recording Window. Click the

Options button in the Recoding dialog box

and the options will appear (see Figure 6).

Another handy feature of the

Recording window is the “Snap window

to fit inside the red recording area” but-

ton. Clicking this button moves the entire

screen being recorded inside the record-

ing area. Another major change to the

recording process is the loss of “full

motion” recording. This required a little

extra work in RoboDemo if you wanted to

record mouse movements. It is now an

automated process in Captivate.

Sound is a major element in any new

media presentation and Macromedia has-

n’t overlooked this feature. You can add

MP3 background audio tracks to the movie

or the slide and record slide-by-slide voice-

over narrations, but the handling of sound

in Captivate has had its molecules turned

inside out and rearranged when compared

to RoboDemo’s abilities.

First, sound is added to the timeline

and double-clicking the sound on the

timeline opens the new Edit Audio dialog

box (see Figure 7). When it opens you can

perform some basic sound editing opera-

tions to the waveform which include

adding silence, deleting sections of the

waveform, and adding normalization to

the waveform to “clean up” the recording.

Another welcome addition to the

audio recording features is the ability to

enter scripts directly into the audio

recording dialog box by selecting View

Script. Now when you click the Record

button, you have the script for the narra-

tion visible right in the Recording dialog

box (see Figure 8).

Creating and editing the movie is

important, but the end game – preparing

the movie for output – is also important.

Again, Macromedia has added some very

important changes to this process. The

first, as noted earlier, is a terminology

change. Movies are no longer exported,

they are “published,” and this process has

been added to and, more importantly,

streamlined (see Figure 9).

Publishing a movie in RoboDemo was

a rather complicated process. Captivate

smoothes out this process and puts all of
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the options in one place for easy access.

Click an output option and the window

changes to reflect your choice and the

ability to access the Movie Preferences to,

for example, change the Playback Control

style or remove the Controller entirely.

One of the major changes to the publish-

ing process is the ability to publish the

movie directly to your Breeze or

BreezeLive server from within Captivate. 

Wait, There Are Flaws...
Though I have sounded pretty posi-

tive about the application there is one

aspect that disturbs me. It is the ability to

export your Captivate movies directly into

Flash MX 2004 or Flash MX Professional

2004. This release marks the demise of the

Flash Module for RoboDemo. Instead of

being a separate product, it has been

folded into Captivate. The issue I have is

the import into Flash. 

First, if you select Import/Export>

Export to Flash you will see a dialog box

that essentially tells you nothing more

than “Click this Button to launch Flash.”

That's exactly what the button does: it

launches Flash. You then have to import

the Captivate file into Flash using the

Import dialog box in Flash (see Figure 10).

If you are familiar with the Quick Export

feature of Fireworks MX, for example, it

strikes me that it makes sense to add this

as a “Launch Flash” button on the Main

Toolbar than as a menu item that implies

more than it does.

When a file is imported into Flash the

entire movie is placed on the Flash time-

line. This means if you have a Captivate

movie that is 30 seconds in duration you

can reasonably expect to see a Flash

timeline that is 900 frames long because

Captivate movies play at a rate of 30

frames per second. When you consider

that there are performance degradations

in Flash when the frame count exceeds

16,000 frames, there are going to be

some issues with longer Captivate

movies. If you are a Flash developer and

think you can get around this by import-

ing the movie directly into the Library,

think again. There is a known Flash bug

involving .png images that will crash

Flash if you try to drag the Captivate

movie clip to the Main timeline.

When you do import a Captivate movie

to the Flash stage pay careful attention to

the Captivate Options dialog box (see

Figure 11). The more items you deselect –

the End Options, Hints, and Playback

Controller are good candidates – the small-

er the movie will be. Also, the Flash Library

is populated with bitmaps for every item

on every slide, each slide is indicated on

the Flash timeline with a Label on the

timeline, and, finally, if you create Question

slides where the user takes a test, these

slides currently don’t import into Flash.

The other “gotcha” to be aware of is

the fact that Captivate movies play at

roughly 30 frames per second. Flash

movies traditionally play at 12–15 frames

per second. If you “downshift” the

Captivate movie to that rate, you will

wind up with fewer Flash frames but the

timing of other media such as sounds

and .swf files containing mouse move-

ments will also be profoundly affected.

Having said all of that, the ability to

move smaller Captivate movies into Flash

allows you to take full advantage of all of

the Flash Player 7 features – streaming

video for example – that are simply

unavailable in Captivate. They may

require a bit of extra work to “clean up”,

but in many respects the effort is worth it.

Conclusion
As you may have guessed,

Macromedia has taken RoboDemo,

turned it inside out, and rearranged its

molecules. The end result is Captivate. I

will tell anybody who cares to listen that

Macromedia has a solid hit on its hands

because it hands Web developers an

easy-to-learn and easy-to-master tool

that allows them to extend their service

offerings. Educators, in both the private

and the public sectors, once they catch

on to what it can do and how easily it

integrates with their existing Learning

Management System, are going to give

this application more than a passing

look. Even so, like all Macromedia prod-

ucts, Captivate is deep, rich, feature

laden, and most important, a heck of a lot

of fun.
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The following week I delivered a sem-

inar and spoke about dynamic technolo-

gy. I was amazed how many did not

know about the built-in features of

Dreamweaver for creating these pages.

As editor-in-chief of this journal, I felt

it was time to rectify this problem fast.

In this article I will demonstrate how

simple it is to create dynamic Web pages

using some of the built-in features of

Dreamweaver MX 2004. For the purposes

of this article, we will use ColdFusion MX

as the server model. However, within

Dreamweaver the other server models

will present only minor differences.

Preparing the Site
If you are going to create dynamic

Web pages, you need a server.

Dreamweaver supports five server mod-

els. Table 1 shows which dynamic model

uses which server.

As I stated from the outset, we will

use ColdFusion here.

Before we begin, you will want to reg-

ister the database with the server.

ColdFusion makes this job very easy. All

you need to do is start the ColdFusion

administrator and select the Data

Sources category under the Data and

Services category (see Figure 1).

You need to give the database an iden-

tifying connection name (it can be a name

of your choosing) and select the correct

driver for the type of database you are

working with. You will see that ColdFusion

has drivers for most of the major database

engines. (Note: ColdFusion uses JDBC driv-

ers.) For the purposes of this article, we will

use a simple Access database that I will call

myDatabase.

Once you have performed those

steps, click Add. You will be taken to a

screen where you can either type or

browse to the URL of the database files,

enter the username and password (if nec-

essary), and add any other information

necessary to establish the connection

with the database engine (see Figure 2).

After you click Submit, you will be

returned to the original screen with the

name of the connection in the Connected

Data Sources grid. You should see the

word OK in the last column to indicate

that the connection was successful. If you

do not see OK, click on the Verify All

Connections button. If OK still does not

appear, check the URL of your connection.

That is all that is needed to connect

the database to the server. From here on

in, Dreamweaver will be doing the work.

(Note: Other database/server combina-

tions will require different techniques.

Unfortunately, a full discussion is beyond

the scope of this article.) Fire up

Dreamweaver and use the Manage Sites

menu option to define the dynamic site.

Begin by giving the site an identifica-

tion name. This name can be of your

choosing and has no bearing whatsoever

on the name or URL of the finished site. It

is used only for identification purposes.

On the next screen you should identify

the server model you will be using. Again, for

the purpose of this article, I am using

ColdFusion.

The next screen is a critical one. Here

you have to be careful where you place

your files. Each of the server technologies

has a root directory that the server can

recognize. For example, ColdFusion has a

directory called wwwroot. The directory

structure of your site should be installed

there or the files may not be recognized

by the server. (Note: If you use IIS, the root

folder is located under Inetpub/www-

root.) Dreamweaver should recognize the

server’s root directory and suggest the

name and location of the directory struc-

ture for your site as shown in Figure 3.

For this article, I assume that we are

not going to use a remote server and will

be testing the files locally. When you get

to the next screen, you will see some-

thing like http://localhost/mysite.

Most ColdFusion server installations
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Model Server

ColdFusion ColdFusion MX

.NET .NET Framework & IIS

ASP IIS

JSP A number of servers including 

JRun and Apache

PHP Apache
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Extension of 
the Month

assaging user input is one of those

tedious jobs most Web developers would

rather do without. But if someone leaves

out important data while filling out a Web form, your

Web application might not work – after all, how can you

e-mail a user his weekly newsletter if he forgot to enter

his e-mail address in the sign-up form? Even worse, bad

data can bring a Web application to its knees. If you’ve

ever tried to insert a word – “one”-- into a database field

meant to hold a number – 1 -- you know what I mean.

WA Validation Toolkit is one extension that can

make this job a lot easier. It lets you add both client -

and server-side validation to your forms. Novices will

like the simple wizard that makes adding validation

just a matter of filling out a few dialog boxes; while

experienced developers can take advantage of

Dreamweaver behaviors or server-side behaviors to

create more complex validation options.

The extension provides 15 types of built-in valida-

tion methods that let you check for data that matches

common patterns such as e-mail addresses, URLs,

Social Security numbers, dates, ZIP codes, credit card

numbers, and more. Of course, it performs the most

basic validation – making sure a field isn’t empty – and

if none of the extension’s other validation types fits

your data,  you can create your own validation pattern

with the extension’s regular expression support.

Using JavaScript, the client-side validation fea-

tures can check for valid input as the user fills out the

form – either triggering JavaScript error boxes

explaining the problem, or making hidden layers visi-

ble. This last option lets you create more professional-

looking error dialog boxes.

The server-side validation features support three

server models – PHP, ASP, and ColdFusion – and let you

validate data from a form after it’s been submitted to

the server. This lets you validate forms even if the user

has disabled JavaScript, and also lets you integrate your

error messages into your Web page,

instead of through a JavaScript alert

box or a pop-up layer. For example, if

the user entered incorrect data, the

form could reappear with the mes-

sage “The information you submitted

is incorrect” at the top of the page,

and individual messages after each

form field holding incorrect data. The

extension can make sure the form

“remembers” data that was properly

entered, so the user doesn’t have to

re-enter everything she typed.

The extension is very flexible with

many options for validating data and

presenting errors. If you find that

your Web visitors consistently supply

incorrect data – or no data at all– this

extension can make sure they fill out

your Web forms the right way.

• • •

Have a favorite extension? Is there an extension

you just couldn’t live with out? We’re always on the

lookout for awesome extensions, so drop us a line at:

DaveMcFarland@sys-con.com

Dave McFarland is the Dreamweaver editor of MX

Developer’s Journal and author of Dreamweaver MX

2004: The Missing Manual. Find out about his latest

projects at www.sawmac.com DaveMcFarland@sys-

con.com

by dave mcfarland

WA Validation Toolkit
Extension Developer: Web Assist

Developer Web Site: www.webassist.com

Price: $99.99

m
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run on port 8500. You may need to

change the configuration to http://local-

host:8500/mysite.

When you test the URL Dreamweaver

should return a message saying that the

URL prefix is correct. From here on in, just

accept the defaults and complete the site

definition.

In order for the connection with the

database to activate, you must open a

dynamic page for the server model. In

our case, this will be a ColdFusion page

(File > New > Dynamic Page >

ColdFusion). Once the page is created, it is

a good idea to save it with the appropri-

ate file extension (.cfm for ColdFusion).

To access the database, you will need

to go to the Database panel, which is part

of the Application Panel Group. You might

need to enter the password for the server.

Once the connection is made, your

Database Panel should show the full struc-

ture of the database as shown in Figure 4.

You can right-click on one of the tables

and view the data inside the table. However,

you cannot edit the data in

this way.

While you can see the

structure, you cannot use

the database directly in a

Web page. Instead, you

must filter the data

through a recordset.

Essentially, this is a SQL

(Structured Query

Language) request for the

data needed. Thanks to

Dreamweaver, an exten-

sive knowledge of SQL is

not necessary; however, it

is helpful.

In the Application

Panel Group, click on the

Bindings Panel. Click the +

button and select

Recordset (Query). Here is

where you will set up the

request. Dreamweaver will

write the SQL code.

Begin by giving the recordset a name

of your choosing. Then, from the drop-

down list, select the database connection

you want to use (the one we set up earli-

er in ColdFusion). If necessary, enter the

user name and password for the data-

base.

Once that is completed, you should

see a list of tables in your database.



Select the table you want, the columns

you want to use from that table, how you

want the data sorted, and any search cri-

teria you might have (an extensive dis-

cussion of SQL code is beyond the scope

of this article). It should look something

like Figure 5. Note that you can select the

columns you want to use by either select-

ing them randomly using Ctrl + click, or

in groups using Shift + click. For this

example, I just selected three columns.

As an interesting note, you can click on

the Advanced… button and see the SQL

code that will be used. If you know SQL,

you can also make any adjustments you

may want to make. Figure 6 shows an

example of this screen. Finally, it is a good

idea to test the recordset by using the Test

button on the right side of the dialog box.

As an interesting aside, you can see

the query code by going to Code View.

It should be located near the top of the

page. It will look something this:

<cfquery name="testSet"

datasource="myDatabase">

SELECT CustomerID, CompanyName,

ContactName

FROM Customers

ORDER BY CustomerID ASC 

</cfquery>

Assuming all is working well, you

should now see the recordset in the

Bindings panel. You are now ready to

insert the fields into the

page. I am going to

show the examples on a

blank page, but in reality,

you would use a page

that had all of the graph-

ics in place.

At this point, there

are two ways you can

approach this. By far, the

Dynamic Table feature of

Dreamweaver is the easi-

est. In Design View,

select Insert >

Application Objects >

Dynamic Data >

Dynamic Table. A dialog

box will open asking you

how many records you

want displayed on a

page. In most cases you

will want to limit the

number of records to 10

or so. You do not want to

throw too much information at the site’s

visitor at once. We will discuss how to

insert navigation shortly. After you select

OK, your page should look something

like Figure 7.

Your page is ready to go. We can test it

by saving the page and either previewing

it in the browser or by selecting the Live

Preview feature just above the document

window (see Figure 8). If you wanted to,

you could easily change the heading text
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of the table to whatever text you need.

In the example shown in Figure 8,

we are just displaying 10 records at a

time. A navigation bar needs to be

inserted that will allow the visitor to

move forward and backward through

the data. Dreamweaver can easily

accomplish this.

Select the entire table that was just

created. Once selected, select Insert >

Application Objects > recordset Paging >

Recordset Navigation Bar. You will see a

dialog box that allows you to select the

recordset you are connecting it with if

you are using multiple recordsets. Since

our example is only using a single

Recordset, I have just clicked OK. Figure 9

shows the inserted Navigation Bar.

When you test the bar in the browser,

notice that First – Previous – Next – Last

turns on and off as needed. Dreamweaver

accomplishes this by writing some tricky

JavaScript code on the page.

Essentially, the job is done. You now

have a dynamic page ready to roll.

However, as I stated earlier, there is anoth-

er way of doing it. In this second case, you

may not want all the fields located in one

place using a table format. This is easily

accomplished by going to the Bindings

Panel and dragging the recordset’s fields

to the position on the page where you

want them. Dreamweaver handles all of

the code in the background.

If, for some reason, you wanted to

change the number of records shown per

page, go to the Server Behaviors Panel

located in the Application Panel Group

(see Figure 10). If you double click on

Repeat Region you will be returned to the

dialog box you saw earlier for the naviga-

tion bar. Here you can change the num-

ber of records to be displayed for each

page.

As you can see, Dreamweaver makes

this whole process fairly simple and

direct. However, it does not end there. We

can take a brief view of a few other fea-

tures to help facilitate your dynamic Web

pages.

If you go to Insert > Application

Objects, you will see that Dreamweaver

has behaviors capable of building dynam-

ic pages to update, delete, and insert

records. In the background, this is essen-

tially being done with the SQL code.

However, the corresponding wizards can

assist you in doing even more.
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One special behavior is the Master >

Detail page. In Web parlance, we some-

times call this drilling down. Here the

user can click on the record that they

want to see the details on. Each record

has a corresponding hyperlink that takes

them to a page that will provide greater

detail.

As an example, let’s try a variation of

the above page. In this case I set up the

recordset with all of the fields. It is not

necessary to drag any of the fields onto

the page at this time. We are going to let

Dreamweaver do all of the work.

Select Insert > Application Objects >

Master Detail Page Set. This is shown,

filled out, in Figure 11.

There are a few things you need to

set up here. First of all, on the Master

Page, you will just want a couple of fields

for identification purposes. In Figure 11 I

just selected Customer ID and Company

Name. I used the – button to eliminate

the other fields. In the Link to Detail

From/Pass Unique Keys fields we can

establish the connecting fields if we are

using multiple database tables to obtain

the information. In this case, since we are

using the same table, the two fields are

the same.

You must then establish the name of

the Detail page. If it has not been created

yet, Dreamweaver will create it for you.

For this example, I called it test3. 

The bottom part of the dialog box

allows us to select the fields for the Detail

page. In this particular example, I am just

going to leave all of the fields selected. 

Once the dialog box is all set up, press

OK and Dreamweaver will do all of the

work for you.  As you can see,

Dreamweaver set up the Dynamic Table,

Repeating Region, and Recordset

Navigation Bar in one shot. If I run the

page, it will look something like Figure 12.

Notice that the Key field has a hyper-

link to take us to the Detail page. As a

small extra, Dreamweaver even shows

you the numbering of the records on the

page out of how many records in the

recordset. If you then click on the hyper-

link, you will be taken to the Detail page

shown in Figure 13.

If you take a peek behind the scenes,

you will see that Dreamweaver did a lot

of coding for you.

Conclusion
As you have just seen, Dreamweaver

can build sophisticated dynamic pages

by just filling in some simple information

in a dialog box. Admittedly, there are

times when you may need to do a little

hand-coding (especially with SQL). But, in

most scenarios, Dreamweaver MX 2004

will do the job just fine.
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t wasn’t so long ago that video and

the Web were at odds. Video was

becoming more beautiful and

entertaining through new post-pro-

duction techniques. And with the prolif-

eration of video editing software and

high-speed buses like FireWire, creative

videos started coming from all types of

makers – from professionals to first-time

home users. The Web, vast but slow,

seemed to be stuck in a rut, resisting

video’s advances by confining it to small

sizes and clunky, boxy players.

Flash Video is changing all of this.

Now, as many of you either create or

have access to great-looking video, you

want to match that quality by wrapping it

in a super online playback experience.

The answer: use Flash Video (see Figure

1). 

Getting Started
In this article, I will guide you through

some of the steps you need to take to

encode and deliver video on your Web

site.  If you'd like to drill down to more

specific Flash Video topics, visit the Flash

Video Developer Center.

Step 1: Create Your FLV File 

A lot of folks get hung up on this very

first step, but it’s actually quite easy. Why

do they get stuck? Some may not under-

stand that although Macromedia pro-

vides the FLV Exporter, you don't use that

within Flash (although you do need to

have Flash MX Professional 2004 installed

to run it). You run the Flash Video

Exporter using video editing tools that

support standard QuickTime export.

With Flash, you can:

• Play back Flash Video on the Web

using Flash Player

• Build custom video players that match

your site design

• Integrate or layer your video with

other elements in Flash, such as anima-

tion, text, or interactivity

Here are a few guidelines to point you

in the right direction.

If You're Not a Video Editor…

Many of you may create or edit video

at work or at home. However, if you don't,

you may have video that is pre-encoded

as QuickTime, Windows Media, or another

type of video file. If this is the case, there

are a couple of easy-to-use tools for you

to convert your file to FLV. 

Note: Compressing and recompress-

ing video is not great for quality. It’s

always better to start with a version of

the video that is closest to the original

source as possible – you’ll really see a dif-

ference in the results.

• Sorenson Squeeze: The encoding folks

over at Sorenson have produced a

great tool in Sorenson Squeeze 4.0,

which you can use to encode your FLV

files (see Figure 2).

A special version of Sorenson

Squeeze is included as part of the

Macromedia Video Kit.  The kit also has

a Dreamweaver extension for adding

Flash Video to your site. You can pur-

chase the Macromedia Video Kit from

the online store.

• QuickTime Pro and Flash Video

Exporter: If you have Flash MX

Professional 2004, you already have

the Flash Video Exporter (see Figure 3).

(It's included on the Flash CD. You can

also download it from the Flash

Support Center as part of the Flash

Video Updater 1.2 [www.macro-

media.com/support/flash/downloads.

html#fmxpro_vid_up]. You need to

have Flash MX Professional 2004

installed to run the Flash Video

Exporter.) This exporter hooks into all

QuickTime-based exporters that ship

with popular video editing software

including Final Cut Pro and Express;

Avid Media Composer, Xpress DV, and

Xpress Pro; and batch encoding appli-

cations such as Discreet Cleaner and

Anystream Agility.

However, if you're not a video editor,

but you do have Flash MX Professional

2004, a cheap and easy way to convert

video files to FLV is by purchasing

Apple's QuickTime Pro for Mac or

Windows (www.apple.com/quicktime).

Simply install the Flash Video Exporter,

and your FLV export options will appear

automatically in QuickTime Pro. You can

save any video file that you can open in

QuickTime Pro as an FLV file.

If You Are a Video Editor…

Many of you edit your own video with

applications such as Final Cut Pro or Avid

video

Encode, Deliver, Design
Getting a grip on Flash Video

by craig goodman
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Media Composer. Since the Flash Video

Exporter works as a plugin to the

QuickTime Export architecture, once you

install it, it will show up as an export

option in applications that support it,

such as Final Cut Express/Pro and Avid

Xpress DV/Pro.

For more information on how the FLV

Exporter integrates with different applica-

tions and how to get the latest version,

check out “Creating Flash Video Files with

Flash Video Exporter.” (www.macrome-

dia.com/devnet/mx/flash/articles/flv_exp

orter.html)

Step 2: Choose How to Deliver Your

Flash Video  

So now that you’ve created your FLV

file, the next step is to decide how you

want it to play back in Flash. Here are

your choices:

• Progressive download video, which

you can do in two ways:

– Embedding your video in your

Flash (FLA) file

– Storing your FLV files externally

• Streaming video

Progressive Download  

Progressive Flash Video download,

which first emerged in Flash Player 6,

doesn't make you wait (and wait) for the

whole video to download before it starts

playing. The video starts its playback as it

progressively downloads segments of the

video, providing a smoother experience

for your users. Many people call this

streaming video, but there is a difference,

as I will explain later.

There are a couple of ways to use pro-

gressively downloaded Flash Video (FLV)

on your site; I'll start with the old way,

which is importing and embedding the

video in your Flash file, then enlighten

you with the new one – playing your FLV

files externally.

Embedding Your Video Within the SWF?

Think Again! 

There’s something I have to say, so I

might as well get it out of the way right

now. Don’t embed your video in your

Flash file unless it’s less than 10 seconds

long. Yes, you heard right. While Flash MX

touted the coolness of being able to

embed video right into the Flash file, I've

got news for you – that's not so cool any-

more. Here's why.

• Differing Flash/video frame rates can

hurt performance. Embedding works

best if your source video and your

Flash movie have the same frame rate.

If they don't, you need to adjust one of

them, and your playback can suffer. 

• Long videos on the timeline can lose

audio/video synch. It’s true – if you

put a long video on the timeline, it's

likely that you won’t be able to keep its

audio synched up after about 4000

frames. Also, a single timeline is limited

to 16,000 frames.

• Stopping the timeline stops your

video. If you embed your video on the

Timeline, every time you stop the

video, you need to stop the playhead

on the Timeline. This is not a very flexi-

ble authoring scenario.

• Download performance can vary.

Some developers place embedded

video in movie clips to get around the

Timeline start/stop issue mentioned

above. However, if you put your video

into a movie clip, that movie clip (and

the video in it) has to download com-

pletely before it will play. This elimi-

nates the progressive download bene-

fit and is a common pitfall for many

developers.

• SWF publishing time goes up. If you

embed your video, you have to repub-

lish the video every time you publish

the SWF file for posting to your web-

site, leading to problems:

– It takes a long time to publish a SWF

with video.

– You can’t alter video content with-

out having to republish the SWF. 

Using External FLVs  

In the Developer Center, most of the

articles recommend placing your FLV files

external to your Flash (FLA) file. This

method, new in Flash Player 7, is fast, effi-

cient, and flexible, and it doesn't require

any additional software. Here are some

more reasons:

• Flash media components are easy-to-

use. The media components make it

super-easy to create a video controller

and playback bar in Flash. Just enter

the URL of your external FLV file in the

Component Inspector panel, and

you're good to go.

• You avoid all of the issues that come

with embedded video. Just take a look

at the list of possible embedded video

performance and development issues I

described above. Use external FLV files

instead, and you can check those off of

things you have to worry about.

• To play external FLVs, simply upload

your FLV files to your Web site. Then,

in Flash MX 2004 Professional, drag a

media component onto the Stage,

select it, and then define the URL of

the FLV file in the Component

Inspector panel. That's pretty much it;

you now have a controller that will

play your video on your site. 

Streaming 

You might be thinking, “That progres-

sive download sure sounded like stream-

ing to me. ”Well, they are similar – both

start playing before the video fully down-

loads and a lot of people use the terms

interchangeably – but they are not identi-

cal. 

True streaming video comes from

playing your FLV files using Flash

Communication Server MX. Is the quality

higher? Well actually, if you're talking

strictly about how the video looks (its

colors and sharpness), progressive down-

load and streaming are the same – a 300

Kbps–encoded FLV file is a 300

Kbps–encoded FLV file – no matter how

it's delivered.

So How Is Streaming Different?

• Streaming video files start playback
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almost immediately, at any point in

the video. While progressive down-

load is a big leap from completely

downloading a video file and then

playing, streaming takes it one step

further. Very little of the video needs

to be present in RAM to begin play-

back. This lets users scrub the video

randomly (even frantically) and still,

the video plays back almost immedi-

ately.

• Streaming video plays without ever

fully downloading to disk. Streaming

FLV doesn't save to disk; there is never

a file copy on a user's hard drive. This is

an advantage to developers who want

to make extra sure that no one can

replay their video files.

• Streaming video only requires Flash

Player 6. This may not be a big deal to

you, however, remember that Flash

Communication server came out

before Flash Player 7, so, you can

stream video to users who have only

Flash Player 6 installed.

• Wait, that's not exactly true. You need

to have access to a version of Flash

Communication Server in order to

stream video. Now, you can do that

through a hosted solution called Flash

Video Streaming Service. 

Step 3: Get Creative: Customize

How You Play Video on Your Site  

Now that you’ve decided how you

will encode and deliver your video, you’re

ready for the creative part – building your

Flash Video player for your Web site. This

isn’t too hard, as Flash MX Professional

2004 has prebuilt media components

that you can simply drag to the Stage

and configure 1n a dialog box. And on

top of that, you can now even use a

handy Dreamweaver extension (included

in the Macromedia Video Kit) to put your

FLV in your page – without even going

into Flash.

However, many of you will want to do

much more. For example, you may want

to create custom video players that inte-

grate with your site. You may also want to

synch the appearance of other graphics

with your video, make your video play

borderless within a scene, or overlay your

video with interactive hotspots. To get

these more customized effects, you need

Flash MX Professional 2004.

If You Are a Flash User…

Flash MX Professional 2004 users get

the best of both worlds when creating

Flash files that host Flash Video. You can

use the Flash media components to

quickly get video into a Flash movie, then

you just publish the SWF and the FLV files

on your Web site. 

If you want to start creating more

complex video presentations, check out

the Flash Video Templates, which you

can download and modify for your own

design and usage. The templates (see

Figure 4) include model sites for play-

ing personal video, corporate video

presentation, a live video Webcast, and

more.

Finally, if you’re a real expert with

Flash, we've provided the source code

(FLA) and documentation for our Flash

Video Gallery application on www.macro-

media.com. 

If You Are a Dreamweaver User…

Some folks who have Dreamweaver

(or even Studio MX 2004) may not be

that familiar with Flash, but want to get

started quickly (and learn Flash later). The

Macromedia Video Kit gives

Dreamweaver users an easy way to place

Flash Video in a Web page – without ever

opening Flash.

The Macromedia Video Kit

includes two very important

components: the Flash Video

extension for Dreamweaver MX

2004, and that special version

of Sorenson Squeeze 4.0 that I

mentioned earlier. With the kit,

you can convert and encode

any video on your computer to

FLV using Sorenson Squeeze;

then, with the extension, you

can place that video on your

HTML page – the extension

takes care of building and configuring

the video player for you.

Where To Go from Here
For more information on how to use

Flash Video, visit the Flash Video

Developer Center (www.macromedia

.com/devnet/mx/flash/video.html),

where you will find the most up-to-

date information, as well as tutorials,

and templates for making the most of

Flash Video. You'll also find articles,

including:

• Flash Video Learner's Guide:

www.macromedia.com/devnet/mx/fla

sh/articles/video_primer.html

Capturing and Encoding 

• Best practices for encoded prerecord-

ed Flash Video: www.macromedia

.com/devnet/mx/flash/articles/flv

 _encoding.html

Putting Flash Video on Your Web

site

• Macromedia Video Kit Tutorials:

www.macromedia.com/software/stu-

dio/flashvideokit/index.html?pro-

moid=devcenter_flvkit_090204

– Presenting Video with the Flash

Video Extension for Dreamweaver MX

2004: www.macromedia.com/

devnet/mx/flash/articles/flv

_tutorial.html

– Creating Custom Flash Video Skins

for Dreamweaver MX 2004:

www.macromedia.com/devnet/mx/fla

sh/articles/flv_tutorial_pt2.html

• Flash Video Templates: www.macro-

media.com/devnet/mx/flash/video_te

mplates.html

• Building a Video Presentation with

Macromedia Flash MX 2004 Media

Components:

www.macromedia.com/devnet/mx/fla

sh/articles/media_components.html

Delivering Flash Video

• Delivering High-Quality Video with

Flash Video Streaming Server

www.macromedia.com/devnet/mx

/flash/articles/fvss.html

For Advanced Flash Video

Developers

• Flash Video Gallery Source FLA File:

www.macromedia.com/devnet/mx/fla

sh/articles/video_gallery.html
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t
he challenge of enterprise-level collaboration is to

make data sharing effective and keep costs down.

Applications built with C++ or Java must be delivered

to the end-users’ desktops along with some piece of the collabo-

ration software. That can be a headache for IT departments

because it is another set of files to deploy, upgrade, and test.

For me, collaboration has a broad meaning: two or more appli-

cations running on distinct computers sharing data. There is usu-

ally some sort of middleware connecting them: software that

moves the data from one location to another.

After spending nearly 10 years in the financial services arena, I

can tell you that enterprise applications are highly collaborative

affairs. Traders need to know current stock prices, orders for buy-

ing and selling equities flow across the Internet, and conversa-

tions between counter parties take place in real time around the

world 24x7.

IT departments in the financial services industry have been

reluctant to place their bread-and-butter applications onto the

Web because the means to push information onto the end-user's

desktop has not been practical. Java applets, which can use Java

Messaging Services, have appeared from time to time. However,

their large downloads and browser-compatibility issues have dis-

suaded IT from heavy investment.

Now the combination of Macromedia Flex and Macromedia

Flash Communication Server (FCS) make it possible for a new gen-

eration of Web applications to take on the collaborative mantle

and challenge traditional desktop applications. IT departments
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finally have the combination that they

have long sought of rapid development,

simple deployment, small download, and

integrated collaboration. After all, most

PCs already have the Flash Player and

that’s all you need. There is no additional

software required. IT departments can

deploy their collaborative applications to

their Web and application servers, and

the users’ browsers do the rest.

This article shows you how to build a

simple collaborative application in Flex

that uses FCS's shared remote objects.

FCS
Most IT departments have heard of

FCS. They see it as a way to stream video

and audio with ease from a central server

to end-user’s desktops. Nonetheless,

many fail to see that beneath the glitz of

those high-bandwidth applications lies a

useful nugget: shared remote objects.

Easy to develop, FCS-based applications

can share data across the enterprise or

around the globe in real-time. Sending

blotters of stock trades, or simply chat-

ting between counter parties, is nearly

effortless for FCS.

Note that Java has its version called

Java Messaging Service (JMS) that has a

number of implementations. CORBA

(Common Object Request Broker

Architecture) often underpins many mid-

dleware systems.

FCS is a piece of software (usually run

on its own machine) tasked with moving

information from one Flash Player to

another Flash Player. Macromedia typical-

ly markets FCS as a way to stream video

and audio to and from the Flash Player.

Proprietary software within FCS makes it

possible not only to broadcast video to

many users simultaneously, but to

receive video as well.

One example application is an online

conference with an interactive white-

board. Each participant has a camera and

the program provides a virtual white-

board. The current speaker’s image is

transmitted to all members of the confer-

ence. As the speaker draws on the white-

board, everyone sees the diagram taking

shape.

In my opinion, the most powerful

aspect of FCS isn’t its ability to share data.

The real power is the fact that it can be

programmed or scripted so its behavior

supplements the application.

I have written Java- and C++-based

applications that use software to share

data with remotely connected users. The

middleware (i.e., JMS or CORBA) is nor-

mally a black box. That is, you can install

and configure it, but you cannot make it

perform any functions that its creators

did not intend.

This is not true for FCS. As with Flash

and Flex, FCS uses ActionScript as its lan-

guage. Each FCS actually runs multiple

applications (see Figure 1). A single FCS

can run a video conference application as

well as a stock price ticker.

For example, if an FCS application is

acting as a chat room, the FCS applica-

tion can save the messages to a database

(using Flash Remoting and a J2EE server).

The FCS application can also authorize

each user that attempts to connect to the

application by allowing or rejecting the

connection.

Flex
Because FCS connects Flash Player to

Flash Player, you must write the user

interface portion in Flash. However, IT

departments have been reluctant to use

Flash because of its reputation as a Web

designer and artist tool. Macromedia Flex

is a new and easier way to write Flash

applications. Flex is ideal for enterprise

development because it uses tools with

which you are already familiar:

Dreamweaver, text editors, and your

favorite J2EE application server (with

.NET on the horizon). Flex application

files are compiled into Flash SWF files and

downloaded into your browser’s Flash

Player plug-in.

Flex applications are written in a form

of XML called MXML (Macromedia’s XML)

that defines the content and placement

of the user interface. There are lots of

controls from which to choose: button,

label, data grid, tree, slider, and so forth.

There are also layout containers to help

manage the placement of the controls. 

Of course, placing controls on a page

would be useless without program code

to control them. Flex uses Flash’s

ActionScript language to provide the

necessary event handling and data man-

agement.

Example: Drag and Drop
I’ve chosen a fairly simple example to

demonstrate how Flex applications can

use FCS to collaborate with one another.
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“the most powerful aspect of FCS isn’t its
ability to share data. The real power is the
fact that it can be programmed or scripted

so its behavior supplements the application”
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This example shows off some of Flex’s

capabilities and it shows how easy it is to

send data between applications. My

example uses the same application for

sending and receiving data.

Figure 2 shows the application in use.

The user peter has entered several orders

directly into the DataGrid component.

Below the grid is a list of the users cur-

rently online, represented by an image.

These images not only tell you who is

online, they are also drop zones – a place

where you can drag one or more orders

(rows in the data grid) to send them to

another user. User peter’s image is

dimmed to indicate that his own drop

zone is off limits.

In Figure 3, user peter is dragging two

orders over the drop zone for user

joseph. Notice how the drop zone high-

lights to indicate that it will accept the

data. If user peter were to try to drop the

orders over his own icon, the drop zone

would not highlight. It would not make

sense to send orders to yourself.

When user peter releases the mouse

over the drop zone, Flex animates the

graphics to show the data falling into the

drop zone. If user peter moves out of the

drop zone and releases the mouse, Flex

animates the data to show it returning to

its point of origin.

When the user releases the mouse

over a highlighted drop zone, the Flex

application extracts the orders from the

data grid and sends them to FCS along

with the name of the target user (i.e.,

user joseph). FCS then takes those orders

and pushes them to user joseph’s Flex

application, which in turn, updates its

data grid.

How FCS knows what to do and how

the Flex application sends and receives

the data is discussed in the section,

Connecting Flex to FCS.

Figure 4 shows user joseph’s grid

after receiving the orders. At this point

user joseph could modify one of the

orders and send it back to user peter by

dragging it over user peter’s drop zone.

The application is written such that it

examines the data being received and

replaces orders it already has (using the

order code). It adds new rows to the grid

for orders it does not have.

Note that the example illustrates just

how easy it is to implement data sharing.

Flex and FCS not only do the job of col-
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laboration, they make it easy to do the

job.

The sample application provides you

with a glimpse of what is possible. If you

choose to download the program code,

make sure you run at least two separate

instances of the application on different

computers to get the full effect. Although

the sample uses fairly simple data (and

an array of order objects), you can send

more complex structures. In fact nearly

anything you can build with ActionScript

you can share.

More Examples
For Example 2, I’ll use the ubiquitous

chat or instant message application. In

this collaboration example, two or more

people exchange messages. Figure 5

shows a multiroom chat application. All

of the users signed on to the application

are shown in the upper-left panel; below

that are the available rooms. To the right,

in the largest space, is the chat dialog

with a tab for each room in which the

user is participating. Below the dialog

area is the input line for entering the text.

Example 3 is one of the most com-

mon applications seen in financial data

systems: real-time price updates. This is

often seen as a band of stock symbols;

prices streaming around the screen; or as

a table of symbols, prices, and other

information.

Figure 6 shows a Flex DataGrid with

currency exchange rates and volumes.

The application works with FCS to bring

real-time information directly to your

desktop.

Connecting Flex to the FCS
Shared Objects 

Flex (and Flash) applications use

shared objects to communicate with FCS.

An instance of a shared object lives with-

in FCS, whereas proxies for it are present

within the Flex application.

In Example 1 there is a list of active

users. I describe the list by labeled

images. When a user signs on to the

application, an image automatically

appears. Similarly, when a user signs off

(closes their browser), their correspon-

ding icon automatically disappears.

To achieve this, I created a shared

object called users (see Figure 7) for the

sole purpose of conveying who is cur-

rently using the application. Within the

FCS application code, I add a new user to

the list whenever an application con-

nects. Because this is a shared object, FCS

automatically synchronizes its list with

those of all of the attached Flex applica-

tions. I coded the Flex applications to dis-

play a labeled icon.

1. Client 1 connects to FCS and attaches

to the shared object, users. This causes

a proxy for the shared object to be cre-

ated in the Flash Player running the

Client 1 application.

2. Later, Client 2 connects to FCS and

attaches to the users’ shared object. A

proxy is created in the Flash Player run-

ning the Client 2 application.

3. The FCS application now synchronizes

all applications attached to the users

shared object. Both applications now

know about each other.

Shared objects can do more than just

share data. You can define functions on a

shared object and have those functions

called by FCS. In the first example, every

user that signs on gets their own unique

shared object. I wanted to define a func-

tion in the sample Flex application that

would be called whenever there was

data to be displayed in the grid. When

one Flex application user drops their

orders onto another Flex application

user’s image, FCS is given the orders,

finds the shared object associated with

the recipient, and invokes the function I

defined.

Making the Connection 
I created an ActionScript class to

make it easy to use FCS from Flex appli-

cations called FlashComm. As this class is

available to download, I will just point

out some of the more interesting

aspects. Following the suggested guide-

lines for Flex classes, my FlashComm

class uses events to announce changes

in its state. 

• Closed, Failed, Rejected: The connec-

tion to FCS can be in one of these

states. My FlashComm class dispatches

a corresponding event rather than dis-

playing an error message. This allows

the overall application to do what is

best at that point.

• Success: The connection to FCS has

successfully connected. Now my

FlashComm class can connect to the

shared objects: users and one specific

to my application instance (users peter,

joseph, etc.).

• Change: FCS has sent some orders. My

FlashComm class dispatches a change

event to inform the application. This

causes the orders to be added to the

DataGrid.

• Users: FCS has resynchronized the

users shared object because someone

has signed on or signed off. My

FlashComm class dispatches a users

event that causes the application to

add or remove user icons on the dis-

play.
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Flex
Listing 1 shows the instantiation of

my FlashComm class within the applica-

tion’s MXML file and some of the events it

handles.

1. The change event is dispatched when

data is being received from the FCS.

The showNewData method either

replaces existing records in the

DataGrid (if the order codes match) or

adds the order to the end of the grid.

2. The list of users is updated whenever it

changes.

3. A dialog box is presented to the user

should the connection fail.

Listing 2 shows the Flex definition for

the list of users. This is defined with a

Repeater tag that generates the items

defined within it for each record in its

data provider. In this case, it would be the

list of users.

The boldfaced lines are the event

handlers for the drag-and-drop opera-

tion. The doDragDrop method is shown

here:

function doDragDrop(event) {

flashComm.sendOrders(dataGrid.selected

Items, event.target.label);

restoreDragTarget(event);

}

Whenever the user releases the

mouse, the selected items (orders) from

the data grid are given to my FlashComm

class to be sent to FCS along with the

name (the icon’s label) of the intended

recipient. FCS then invokes the

receiveOrders method defined on the

recipient’s unique shared object.

FCS Application 
The last part of the example is the

code that is run by FCS itself (see Listing

3). This is the application instance that

makes the example work.

1. When the FCS application starts, it cre-

ates the orders shared object (if it

already exists, the application attaches

to it). Note that shared objects can be

also be persistent. FCS will write their

contents to a local file on the server

and reload them whenever necessary.

2. When a client connects, a function is

defined on the client connection that

the client can invoke. This function

takes the orders from the client and

calls the receiveOrders method

defined on the shared object. This is a

powerful concept. What appears to be

a single method invocation is actually

many method invocations – one for

each client connected to the same

shared object.

If you have used other types of mid-

dleware (e.g., a CORBA-based system or a

JMS system), imagine having the ability

to place code in the heart of the data

switch. In this example, FCS is distribut-

ing the data to everyone. However, it is

possible to filter the data, sort it, save it,

or augment it. You could, for example,

see if the user about to receive the data is

privileged to see all of the data and, if

not, remove those bits not allowed. Or

the FCS application could send the data

to a J2EE server for storage.

To Collaborate Is Human
We have a need to work together;

businesses thrive on this interaction.

Traditional methods of sending data

between applications, whether it be via

serial line or Internet (using protocols

from FTP to CORBA), have been complex

to implement and deploy. I have tried to

show the potential of combining FCS

with Flex: powerful data collaboration

coupled with sophisticated user interface

controls delivered within a Web browser. 

FCS is surprisingly easy to use. The ability

to tailor each FCS application with your

own code opens the door to great possi-

bilities. I used the drag-and-drop capabil-

ities of Flex to illustrate how easy it is to

adopt a new paradigm for a common

goal.

I have developed similar Java-based

applications using Swing for the user

interface and an implementation of the

Java Message Service as the middleware.

Flex and FCS are, in my opinion, a tonic

for the developer’s soul.

Resources
• The source files for this application are

available in ZIP format from my Web

site at www.keaura.com/flex.

• More information about FCS can found

on Macromedia’s Web site at

www.macromedia.com/software/flash-

com.

• Macromedia Breeze is another exam-

ple of collaboration. Find out more at

www.macromedia.com/software/

breeze.

Peter Ent is a Web application developer

specializing in Rich Internet Applications.

He has more than 20 years of experi-

ence ranging from keypunches to wire-

less PCs. peter.ent@keaura.com
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“FCS is surprisingly easy to use.
The ability to tailor each FCS

application with your own 
code opens the door 
to great possibilities”
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<!-- Instance of the FlashComm object. Note how the events

declared in the

ActionScript file are named here and processed.

-->

<FlashComm id="flashComm"

change="showNewData(event)"

users="updateUsers(event.data)"

failed="mx.core.Application.alert('Failed to connect to the serv-

er','Alert')" />

Listing 2

<mx:Repeater id="dropZones" dataProvider="{userList}"

recycleChildren="true">

<mx:VBox width="100" label="{dropZones.currentItem.name}"

dragEnter="doDragEnter(event)" 

dragOver="highlightDragTarget(event)"

dragExit="restoreDragTarget(event)"

dragDrop="doDragDrop(event);

dataGrid.selectedIndices=null;" >

<mx:Image source="@Embed('computer_mail.gif')" />

<mx:Label text="{dropZones.currentItem.name}" widthFlex="1"

textAlign="center" />

</mx:VBox>

</mx:Repeater>

Listing 3

/* onAppStart is invoked when the application is initially

loaded.

*/

application.onAppStart = function()

{

// Get the server shared object 'orders'

application.rowData_so = SharedObject.get("orders", false);

}

/*

* onConnect is invoked every time a client connects. The

newClient

* object is created automatically by the Flash Comm Server to

represent

* the client connection. The name parameter was passed from the

client.

*/

application.onConnect = function(newClient, name)

{

// Make this new client's name the user's name

newClient.name = name;

// Accept the client's connection. You could also reject this

// connection if appropriate.

application.acceptConnection(newClient);

// The client will call this function to get the server

// to broadcast the orders to everyone. The 'receiveOrders'

// method being remote invoked has been defined by each client.

newClient.sendOrders = function(orderData) {

application.rowData_so.send("receiveOrders",this.name,orderData);

}

}



hat does data look like?

To a stockbroker, data

might appear as a stream

of company names and stock values. A

database administrator probably sees

data as a series of tables. A developer

working in XML might see data as a tree

like structure.

This article is all about data. We will

look at data, data structures, data trans-

formations, and data bindings and exam-

ine their role in the Flash MX 2004 com-

ponent framework. We’ll use this informa-

tion to build our first RAD App in Flash,

an XML-driven data consumer.

Variables are the most basic abstrac-

tion of data (see Figure 1). Some symbol

is assigned to represent some value. Just

like in a stock ticker, a name is associated

with a value. This works great for simple

things such as stocks, names or ids, but is

not very useful when dealing with more

complex data models. Variables are not a

good tool to organize the multiple pieces

of information that are needed to repre-

sent a student, an employee, or a prod-

uct.

Object-based data modeling employs

the concept of special variables, called

objects, which are able to hold multiple

values called properties (see Figure 2).

(Objects also have specific functionality

associated with them, things that they

can do, called methods. This discussion is

limited to object properties.) Properties

are like a variable inside a variable. With

properties, a single variable can hold all

of the values we need to represent some-

thing from the real world. A student

object can have names, ids, courses, and

grades. Products can have names, ids,

descriptions, suppliers, prices, etc.

Properties provide an intuitive way of

accessing data by simply using object

and property names. One variable can

encapsulate all of the values needed to

define a specific item. Now, how do we

handle working with many items?

Arrays provide a handy storage con-

tainer when we’re working with many

related things. Arrays are nothing more

than special variables that allow us to

store multiple values at different posi-

tions, indexed by number. This allows us

to gather like things together into one

easily manipulated collection. Arrays (see

Figure 3) are the filing cabinets and shop-

ping carts of the developer’s world. 

Objects are the things we need to col-

lect and store. Arrays are where we store

things. Put the two together and we get:

arrays of objects. While there are many

other data structures out there, arrays of

objects are a key building block for data-

driven applications in Flash. Data from

SQL queries and XML structures will

appear as arrays of objects in Flash (see

Figure 4). 

The ComboBox, List, and DataGrid

components all use arrays of objects as

their data providers. While the DataGrid

is happy using any array of objects as a

data provider, the List and the

ComboBox can take advantage of special

data providers, which use an array of

specially formatted objects. List and

ComboBox components like data

providers where the array’s objects have

only two properties; label and

data (see Figure 5).

The objects returned in

arrays from SQL queries and

XML structures can be

rearranged into objects having

label and data properties.   

Programmatically, this is

done by looping over the

source array and using the

properties of the source array’s

objects to create a new array.

Properties of the source array’s

objects are used to build the

special objects that have label

and data properties. 
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XML
Another way to run your Flash application

by art phillips

w

figure 1

figure 2

figure 3

figure 4

figure 5



While this transformation of

objects is not very difficult, Flash’s

component framework makes it

even simpler. The component bind-

ing interface provides a simple for-

matter that rearranges the proper-

ties of a source array’s objects into

data provider objects with label and

data properties. This is the process

shown in Figure 6. We will use this

technique when we build our XML-based

application.

XML provides a simple markup that

describes data and its structure. It is very

flexible, allowing developers to create

their own data structures. The rules for

forming the structures are contained in

the document’s schema. XML’s flexibility

makes it an important part of Web servic-

es and will be examined in a later article.

XML has the additional advantage of

being simple, uncompiled text. No spe-

cial programs are needed to read or write

XML documents and no special servers

are required if the XML exists as text doc-

uments. 

With XML, tabular data (see Figure 7)

can be represented as a simple tree-like

structure. As with HTML, line breaks and

white space can be used to make the files

more readable. While a visual examina-

tion of an XML document may clearly

reveal the document’s structure (see

Figure 8), navigating that XML structure

in Flash is slightly less than intuitive.

Navigating XML structures program-

matically in Flash requires the use of hier-

archical syntax. While the syntax is not

overly difficult it lacks the intuitiveness of

working with the numbered elements of

an array and the named values of an

object’s properties. Even examining XML

in Flash’s debugger can be awkward. 

Flash simplifies things for developers

by making XML appear as an array of

objects in the component interfaces (see

Figure 9). The XML connector’s results

displays XML’s characteristic structure,

but the same XML in the bindings or

schema tabs of the component inspector

appears as an array of objects (see Figure

10). Visualizing the data this way makes

working with XML much more intuitive.

Putting It Into Practice  
Let’s put all this into practice and

build our XML-driven Flash application.

We will load XML representing a catalog

of products into Flash, build a master-

detail view, and do a little custom format-

ting and coding. 

Remember, all component-based

data integration in Flash follows the same

basic steps: 

1. Add a data connector 

2. Provide connection information

3. Add UI components

4. Bind UI components to data and each

other

5. Trigger the data connector

We’ll start with a new Flash docu-

ment. (We’re supposed to call them Flash

documents these days, but they’ll always

be Flash movies to me.) Save the docu-

ment into a directory that has the data

source, products.xml in it. 

Step 1

Add an XMLConnector from the com-

ponents panel to the document. The

XMLConnector does not render, it is invis-

ible in the final application. It is usually

placed just off of the stage. Give the

XMLConnector an instance name of cxn

(see Figure 11). Next we provide the con-

nection information.

Step 2 

With the XMLConnector selected on

stage, go to the Parameters tab of the

Component Inspector. Set the URL to

products.xml, and direction to receive.

Leave the other parameters at their

defaults. It is especially important to

leave ignoreWhite set to true. This pre-

vents Flash from trying to interpret

spaces in the XML as data (see Figure 12).

Move over to the Schema tab of the

Component Inspector. Here, we provide

the connector with a sample of our XML.

From that sample, Flash will figure out

the document’s schema, the structure of

the data. This will allow us to bind UI

components to the XML data by the

properties names. First be sure you select

the results property, not the param prop-

erty. Then, use the Import schema button

to open products.xml. Notice that the

XML is displayed as an array of objects

after importing (see Figure 13). 

Step 3

For the UI components we will use a

List component and two Label compo-

nents. We will give the List an instance

name of myList and the two Labels

instance names of price_lbl and descrip-

tion_lbl. We are ready to bind the results

of the XML connector to our List.

Step 4

Select the XMLConnector on the

stage and move to the Bindings tab of

the Component Inspector. Click the plus

sign ( + ) to add a new binding. Select the

product : Array in the Add Binding win-

dow, then click OK. Back in the bindings

tab, move down to the bound to field

and bind to the myList List component as

a DataProvider array. The final binding

will look like Figure 14.

Step 5

We want our data to load as soon as

our application opens. The best way to

do this is with some actionScript in the

first frame of our application. Add an

actions layer and select frame 1. We will

use a behavior to trigger our data con-

nector. Flash behaviors, like Dream-

weaver behaviors, are code snippets that

have been prebuilt for us. Move to the

Behavior Inspector and click the plus sign

( + ) to add a new behavior. Choose Data

> Trigger Data Source and then select the

XMLConnector: cxn (see Figure 15). Our

application is ready for the first test.
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Test the application; compile and

open the SWF. If all has gone well, the list

is populated with data. If the list isn't

populated, go back over the steps. Be

sure the XML and SWF are in the same

directory, check names, bindings, etc.

Sometimes it is quicker and easier to just

start over again and rebuild the applica-

tion from the beginning.

If the list populated, you may be sur-

prised at the results. Each list item shows

all of the properties for that object in a

single comma-separated line. To control

how the results are displayed in the List,

we need to change how the results are

bound to the List’s data provider. We

need to transform properties of the

XMLConnector’s results into label and

data properties in the data provider for

the list. Flash provides a simple way to

accomplish that transformation. 

With the XMLConnector selected, in

the Bindings tab of the Component

Inspector select the results.catalog.prod-

uct binding. From the formatter field

choose Rearrange Fields. The Rearrange

Fields formatter provides an easy way to

use simple statements to perform data

transformations.

Enter label=name;data=. into the for-

matter options exactly as written, with no

extra spaces. Now, let’s pick that state-

ment apart.

The label=name assignment says:

take the name property from the source

object and assign it to the label property

of the data provider object. The semi-

colon is used to separate assignments.

The data=. assignment says: take all of

the properties of the source objects and

assign them to the data property of the

data provider objects. The period ( . ) rep-

resents all of the current data or all of the

data at this point. The data property of

the data provider objects now holds all

the properties of the source object.

By using rearrange fields we have cre-

ated a useful data provider for our List.

The label property of the data provider

objects will automatically show up as

labels in our list. The data properties of

the data provider objects hold all of the

original data for that object. In this exam-

ple the object represents our XML values.

In future examples, the data provider’s

data property will be a record from a

database and the data properties will be

the fields from a record.

XML and Flash
This concept of labels and data is a

step ahead of normal form objects in

HTML. Normal HTML form objects have

labels and values. HTML drop-down

boxes and list objects show a label to the

user that represents some simple value.

With Flash components the label can rep-

resent complex data. In a Flash List, the

data provider object’s label property is

shown to the user. We can then access

that item’s data property to get any value

we need for that object. This provides a

simple means of creating data drill

downs in master-detail views. Details can

be easily retrieved from a selected item’s

data property. We will use this as we bind

our remaining components.

We will bind the List component to

the Labels. When the user selects a list

item they will see details about the

selected item in the Labels. I like to work

with data in Flash in the direction it is

traveling. When we connected the

XMLConnector to the List we started by

selecting the XMLConnector. To bind the

List to our Labels we start by selecting

the List.

With the List selected, go to the

Bindings tab of the Component

Inspector. The binding from the

XMLConnector is already listed. Click the

plus sign ( + ) to add another binding.

The Add Binding window opens with a

number of different choices. Remember,

we need to bind to a property of the

selected item’s data. The Add Binding

window provides a binding to

figure 8

figure 9

figure 10

figure 11

figure 12
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selectedItem : Object but it does not

expose the selected object’s data proper-

ty. The Use path expression check box

provides a way to bind to data that is not

exposed in the list.

Check the Use path expression check

box at the bottom of the Add Binding

window. In the field below it enter

data.price (see Figure 16). This creates a

binding to the price property of the

selected object’s data property. Click the

OK button to close the Add Binding win-

dow. 

Use the bound to field of the compo-

nent inspector to complete the binding.

Select price_lbl as text : String to be the

end point of this binding. 

Click the plus sign ( + ) and repeat the

binding process. Add a new binding from

the selected object’s data.description

property (Remember to turn on Use path

expression.) bound to description_lbl’s

text : String.

During testing, clicking on an item in

the List now reveals details in our Labels.

We have a basic model for data drill

down interfaces but there are two small

issues.

When the data loads into the list it is

not sorted; it comes in ordered the way it

is written to the XML. It may be useful to

sort the List alphabetically for the user.

The other issue is that it would be nice to

put a $ in front of the price in the Label.

We’ll take care of that first by using a new

formatter; Compose string. 

Select the List on stage and go to the

Bindings tab of the Component In-

spector. Choose the selectedItem

.data.price binding from the list. Below, in

the formatter’s field, select the Compose

string formatter. From the formatter

options field open the Compose String

window. The String template field will let

us mix literals such as the $ sign with

data. Literals are put in the String tem-

plate field without markup. Data must be

enclosed in < >.

Enter $<.> in the String template

field. The $ sign is literal and <.> says use

the data at this point. The data at this

point in the binding is the price. Close

the Compose String window and our

price formatting is finished. Now to sort

the List.

Sorting the List takes just a little bit of

code, which can be put into many places

in a Flash movie. There are many good

reasons to keep all of a project’s code in

one place such as frame 1 or external

files. However, placing code directly on

an object provides a very direct method

and allows for the use of a simpler syntax

for the event handlers. To sort the list we

will use this simpler, more rapid method

of placing the code directly on an object.

The XMLConnector will be the object we

place the code on.

Select the XMLConnector on stage,

open the actions window, and enter the

following code:

on(result)

{

this._parent.myList.sortItemsBy("label

", "ASC")

}

This code says: when we get results

from our call for XML, sort myList using

the label property.

That finishes the application for this

article. In upcoming articles we will build

applications using information returned

from a database via Web services and

Flash Remoting. 

Summary
In my next article we will build the

data sources we will use in those future

applications. Even though data can be

supplied to Flash by many back ends,

our data sources will be implemented

using ColdFusion components (CFCs).

CFCs provide a wonderfully simple way

to create Web-based data sources. Next

time I will show you how eight simple

lines of code can create both a Web

service and a Flash Remoting data

source.

Arthur Phillips has been delivering cut-

ting edge training solutions since 1984

and has developed instructional materi-

als for George Washington University,

the Federal Reserve Board, the U.S.

Graduate School, and many others. Art

has an extensive background in video,

multimedia. electronic graphics, Web

development, and e-Learning. He holds

too many certifications as a Macromedia

instructor, designer and developer to list.

His Web site (www.artswebsite.com) is a

well-known resource in the Macromedia

community. art@artswebsite.com
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BATCH PROCESS
by joyce j. evansA timesaving system
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A
lot of tasks required to develop a

Web site are repetitious and

tedious. Have you ever had a

folder full of images that you needed to

add a border to? Or perhaps you want to

reduce the size of every image. You’ll

probably even need to optimize each

image as well. Well you can do all these

tasks and more by running one batch

process in Fireworks! What a timesaver,

and it’s so easy to do! 

To run a batch process, follow these

steps:

1. Select File @> Batch Process. You do

not need to have a document open to

use batch process.

2. The Batch dialog box opens. Navigate

to the folder containing the images

you want to use in the batch process.

3. Select each image you want in the

batch and click the Add button. If you

want all the images, simply click Add

All. You can also navigate to other fold-

ers and add images as well (see Figure

1).

4. Once the images are added, click on

Next.

5. If you want to export the images and

choose optimization settings, click

Export in the Batch Options window

on the left. Click the Add button and it

will appear on the right in the Include

in  Batch area.

6. The Export settings field becomes

available. Choose JPEG smaller file (or

whatever you’d like). If you want to

customize the settings, click the Edit

button and choose your settings.

Note: The image shown here shows

the Scale options. This is the same area

in which  you’ll see the export options

appear.

6. If you want to scale the images, select

Scale then click Add. Once you add the

Scale option there will be a drop-down

menu with options to scale to a specif-

ic size, area, or percentage. Fill in your

specifics.

Tip: If your images are not all the

same size you may want to use a per-

centage scale. A specific size works great

for thumbnails and other images only if

all the images are the same size.

7. If you want to run a command in the

batch, then click the plus (+) sign next

to Commands and select the com-

mand you want to use. The commands

shown are the same as the commands

in the Command menu. Even your cus-

tom commands will be shown here

and available to use (see Figure 2).

“What a timesaver, 
and it’s so easy to do!”
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Tip: One command I use frequently

for photo galleries is a border command.

I simply open a photo, and add a glow

effect. Select the image, Click the plus

sign in the Effects panel area of the

Property inspector and select Shadow

and Glow|Glow. The settings used are 1

(or whatever border size you want), soft-

ness of 0, and opacity of 100%. Open the

History panel, select “Set Effect”, then

from the History options popup menu

select Save Command and name it. It will

be available immediately in the

Commands menu.

8. Click the Add button.

9. After you finish setting the batch

options, click Next. 

10. The last Export Options dialog box

lets you pick how and where to save

the processed files. The options are as

follows:

– Save in the same location as the

originals. (If you do, a new folder is

generated.)

– Choose Custom location so that you

can then browse to select.

– Backups, if selected, give you the

options of overwriting existing or

making incremental backups.

– Save Script enables you to save the

batch configuration you just set up.

The script will be saved in the

Fireworks /Commands folder.

11. Once your settings are complete, click

on Batch. When it’s complete, click OK.

12. Check out your changes by opening

one of your batched images from the

location in which you saved it. 

Now wasn’t that easy? And you just

saved a ton of time.

Joyce J. Evans is a training veteran with

over 10 years of experience in educa-

tional teaching, tutorial developement,

and Web design. She has presented at

conferences such as Macromedia MAX

2003 and TODCON. Joyce has

authored books include Macromedia

Studio MX 2004 bible, Dreamweaver

MX 2004 Complete Course, and others.

Joyce is a Team Macromedia volunteer

and her work is also featured in teh

Macromedia Design/Developer center.

Her Web site is www.JoyceJEvans.com

joyce@joycejevans.com
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1. Create a custom default
page.

Set up a page the way you like it

(fonts, styles, colors, page size, guides)

and save it as a FreeHand template in

FreeHand’s Settings folder. While in

FreeHand, open the Preferences/

Document panel and choose your new

template. 

2. Create personal 
keyboard shortcuts.

FreeHand allows you to make your

own keyboard shortcuts for virtually

every tool and function (Edit>Keyboard

Shortcuts). You can start with shortcuts

from other programs such as Illustrator,

QuarkXPress, CorelDRAW, Fontographer,

Photoshop, and more. Almost all my

shortcuts involve the use of my left hand

exclusively, leaving my right hand free for

my digital tablet’s pen.

3. Create symbols of com-
monly used objects.

Make logos, address lines, and other

objects that you use on a regular basis

into symbols. Make the library part of

your default (startup) page so that

they’re available all the time (such as the

one seen in Figure 1). Export a library of

them to use in older documents or to

share with other team members.

4. Make a Custom Styles
Panel.

If you do a lot of line drawings, create

a style for each line weight you use all

the time, and a duplicate of that style

with a white fill so you can spend your

time drawing instead of running through

the Object panel.

5. Use the Transform panel
to scale several objects at
once.

Select any number of objects and

enter the scaling percentage into the

entry fields. Click the Scale button and all

objects will be scaled relative to the com-

mon center point as if they were

grouped.

6. Use Find and Replace to
resize objects.

If you choose Scale in the F&R panel,

objects will be scaled relative to their

own center points – they stay in place.

7. Customize your toolbars.
By placing useful tools in your tool-

bars and removing tools you don’t use,

you can speed up your productivity by

saving trips through menus. You can

place the tools in the Main Toolbar which

runs horizontally across the screen, or in

the Tools Panel which is reshapable and

can be placed wherever you want on the

screen.

8. Use multiple views while
you’re working.

Select Window>New Window to cre-

ate a duplicate window of the current

window. Then you can change the view –

say zoom in for an extreme close-up of a

detail – in one window, while seeing an

overall view in another window.

Anything that is done in either window

occurs live in other windows, allowing

you to see the forest and the trees!

Figure 2 shows three separate views of

the same page; look closely and you can

see that the gray rectangle is selected in

all three windows. On a Windows

machine, you can have FreeHand

arrange the windows automatically by

choosing Window>Tile Horizontally or

Window>Tile Vertically. 

9. Colorize your layers.
Okay, some programs do this auto-

matically, but you can make the selection

points and paths a different color on

each layer to make object selection visu-

ally easier. Just drag a color onto the blue

square next to the layer’s name in the

Layers panel. 

10. Select all objects on a
layer at once.

Hold down the Option/Alt key as you

click on a layer’s name in the Layers

panel. All objects on that layer will be

selected. Add the Shift key and click on

another layer to add those objects to the

selection.

11. Attach text to an ellipse.
Draw an ellipse and type some text.

Use the Pointer tool to drag a selection

box around both (or Shift-select both

objects). Choose Text>Attach to Path. The

text will flow completely around the

ellipse in a clockwise direction, becoming

upside down on the bottom of the

ellipse.
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12. Place text on the bottom
of a circle.

To have right-reading text at the top and

at the bottom of an ellipse, type the text that

goes at the top, followed by Return/Enter, and

the text you want at the bottom. To get text

at the bottom only (as shown in Figure 3), just

press Return/Enter before entering the text

you want on the bottom. The action creates a

blank line on the top of the ellipse, and places

the text at the bottom. The center point of the

text will be at the top of the ellipse.

13. Move text along a path.
Whenever you choose Text>Attach to

Path, a tiny triangle appears at the center of

the text, regardless of any text alignment you

may have chosen. Click and drag the triangle

to move the text along the path. In the case

of an ellipse, the text will run upside down.

14. Get coffee while you’re
waiting for overlapping
Lens fills to redraw.

It’s not a good idea to have many

overlapping Lens fills – your computer

hates it, and the printer will probably

choke. Instead, simplify your design so

the overlaps are not needed, or use

Modify>Combine>Divide to create small-

er, more easily manageable areas that

you can fill without using the Lens fill. 

15. Check the Document
Resolution when you’re
using Raster Effects.

FreeHand sets any Raster Effects to a

72-dpi resolution. That means when the

document window is at 100% viewing

size, everything will look fine and dandy.

Zoom in, and you can see that everything

is bitmapped (see Figure 4). It will print

that way. In case you weren’t paying

attention: IT WILL PRINT THAT WAY! You

can change the resolution of that object

only by going to the Object panel, open-

ing the Options fly-out menu, and chang-

ing the resolution in the Object

Resolution window. At this point, you can

also opt to “Use document Raster Effects

Resolution” by clicking the box. On the

other hand, you can go to

File>Document Settings>Raster Effects

Settings and change the resolution of the

entire document. It’s best to work in the

default 72-dpi mode until you’re ready to

print. Then change your settings to 300-

dpi to print because the hi-res effects

take longer to redraw onscreen.

16. Think twice about using
Raster Effects.

I know, it seems like a lot of cool fea-

tures, but there are two major problems.

First, colors in the affected object are con-

verted to RGB. That means the printer has

to reconvert them to CMYK when print-

ing. You have no control over that

process, so results may vary from what you

expect. Second, these graphics are sur-

rounded by a rectangular bounding box. If

that box overlaps a similarly effected object

or a colored area, the bounding box shows

up as if you had applied a Lighten Lens fill to

the rectangle. It will print that way. So, work-

ing illustrators build these effects the old

fashioned way – as vectors, or from a

bitmap editing program such as Photoshop.

17. Don’t expect to edit a
photo in FreeHand.

FreeHand is a vector drawing pro-

gram, and largely ignores bitmap objects.

You can import a grayscale TIFF file and

adjust the contrast and brightness, but

you can’t do any retouching. You can

change the color of that image from

black to any color you wish however. Just

select it, and choose a color – this only

works with grayscale images, though.

18. Change text color the
easy way.

It’s easiest to change the text color

while it’s live text. Select the text with the

Text tool and choose a color. But if you’ve

converted the text to paths, it’s not that

easy – in fact, that method only makes

you emit loud painful noises. Instead, you

must subselect the text by one of three

methods: Select the text/object and dou-

ble-click Contents in the Object panel.

Repeat until you see the correct text

11 • 2004
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Trace problematic fonts.
On a Mac, some Multiple Master

fonts look fine on screen, but

change to another font weight

when converted to paths (see Figure

6). To retain the on-screen image,

trace the text with the Trace tool.
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color appear in the color well in

the Tools panel. Then change the

color. (see Figure 5) Another

method is to select the

text/object and choose

Edit>Select>Subselect until you

can make the change. The best

way is to use a custom keyboard shortcut

for Subselect (I use Command+Option+X

or Control+Alt+X) to quickly burrow

down to the nitty gritty. 

19. Use Master Pages for
layout approval.

If you have to create the look for a

Web page or brochure and you’re down

to color choices, make a Master Page of

all the elements that could have their col-

ors change. Then set up a page with ele-

ments that won’t change. Make dupli-

cates of the Master Page, and edit them

for color. With the common element

page open, apply one or another of the

Master Pages to it and see the effects

immediately. Yes, you could simply dupli-

cate the pages, make color changes, and

then click between pages, but using

Master Pages means you can make global

changes somewhere down the line.

20. Import tables directly
from Excel.

Just save the Excel file as a Tab Delimited

file and it will import fine. Each cell’s informa-

tion will be intact. No, it will not “function.”

Any formulas or cell references will be inac-

tive, but the resulting data is there. 

21. Use custom views.
If it’s common for you to create a simi-

lar layout for many jobs – such as product

labels – create a template that contains

custom views. Zoom in on the product

name area and save a custom view

(View>Custom>New), then go to the

directions or application area and do the

same. Make a view for every instance that

you usually need; then save the document

as a template (or Master Page). Then you

can choose the working view you need

from the View menu in the

Toolbar, or from the

Magnification menu at the bottom left

corner of the application window.

23. Instead of Copy and
Paste, use Clone.

Artists coming from the “other side”

will spend a long time trying to find

“paste in front/back.” In FreeHand, clone

the object and it’s automatically copied

and pasted directly in front of the original

object and remains selected. 

24. Use the Option/Alt key
for copies.

Select a text block on an object. While

the mouse is down, depress the

Option/Alt key and drag the mouse. A

clone of the object will be moved. 

25. Power duplicate.
Most people don’t take advantage of

the power duplication feature in FreeHand.

Select an object, and either clone it and

move it, or use the previous tip to

Option/Alt+drag to move the clone to a

new location. Then choose Edit>Duplicate

to move a new clone exactly as the previ-

ous object was moved. That includes hori-

zontally and vertically, so you can place

objects on an angled line if you want. 

27. Time heavy extrusions
just before lunch.

If you have an object that contains a lot

of smaller objects or compound paths (read:

text) and you apply an extrusion to it, time

will be a minor factor. But it becomes a mon-

strous factor if you apply a bevel to the extru-

sion. Increase shading or bevel steps above

the default of 5, and you have an even more

time consuming process. Moving such an

object a pixel or two can cause a wait-time of

several minutes or even more than an hour.

When it happens, Force Quit FreeHand and

start again with a less vigorous extrusion.

28. You’ve heard it before:
Vote Early and Vote Often.

Oops, wrong saying. What I meant

was SAVE early and often. Especially

before doing a memory-intensive task

such as extrusions, tracing, switching to

other documents or applications, and

even printing. You’ll breathe a lot easier

knowing that you won’t have to start

from scratch if the computer hangs. 

29. Option/Alt+drag guides.
Instead of traveling back and forth to

the top and left of the screen to create

figure 5
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Power do a lot of things.
You can create a clone of an object, rotate it, scale it, skew it, and move it. Then

choose Edit>Duplicate as many times as you want to keep the process going. It’s an easy

way to create a path of objects getting smaller or larger on a spiral (see Figure 7).

figure 7
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multiple guidelines, power-drag them.

Save time and exercise by creating one

guideline for horizontal or vertical, then

press and hold the Option/Alt key as you

drag multiple guides from the original. 

30. Place Guidelines 
accurately.

We often overlook the precision

FreeHand offers us. If you open a new docu-

ment and go to Guides>Edit menu, you can

select the Add button. That opens a new

dialog box where you can choose from hori-

zontal or vertical guides, and then enter

numbers that put guides exactly where you

want them – you don’t have to try to make

the guides snap to the rulers! In fact, you

can create a grid very quickly by using “Add

by”count or increment. Note that the

guideline grid you create will not act the

same as a true Grid, also found in the View

menu. You won’t have the same snap-to

attribute, and the guides are moveable –

unless you lock them (View>Guides>Lock

or lock the Guides layer in the Layers panel).

32. Create vector shadows
with Contour Gradient Fills.

Start as in #31, and make the outer

shadow shape. Then apply a Contour

Gradient Fill, using the appropriate shadow

and background colors. Adjust the contour

ramp until the shadow looks right.

33. Can’t open an EPS file?
FreeHand doesn’t have a PostScript

interpreter. Therefore, you can’t work

“inside”an EPS file. If you’ve exported a

document as an EPS and checked the

“Include FreeHand Document”box,

then you will be able to work with the

file. If not, you must open the file in

Adobe Illustrator. At that point you may

be tempted to just do the job there,

but fight those urges! Be Strong!

Persevere! Export the document from

Illustrator as an Illustrator 8 or 9 file.

Then open that document in FreeHand.

34. Consistent color.
Pick just about any color from the

Pantone Swatch list, and drag it to the

Mixer panel. Note the CMYK color break-

down. Now go to Adobe Photoshop or

Illustrator and select the same Pantone

color and note its CMYK values. Who do

you trust? It’s a tough question. I rely on

printed sample books from Pantone

because I’m looking at actual printed

examples of CMYK on paper. Trust the

numbers. If I’m matching colors in a

Photoshop image, I use Photoshop’s eye-

dropper tool to get the color breakdown,

and create a custom color in FreeHand

using those values. Or I create my color in

FreeHand and use those values in the

Photoshop document – it works both

ways. The Pantone books are not cheap,

but it’s a pretty inexpensive investment

compared to reprinting an entire print job!

35. Create quickie Web
page navigation with the
Action tool.

The Action tool is so easy to use it

should be illegal! Choose the Action tool,

and click the “button” on the current page.

Then click on the page you want the but-

ton to link to. Continue through the entire

layout. Finished results can be seen in

Figure 9. It takes seconds, and there’s no

code to write! Choose File>Publish as

HTML, and sit back. The screen redraws

and partially redraws for a few seconds

and becomes still again. Go to the folder

you’ve created (pay attention to the loca-

tion as you’re publishing), and double-click

the first page. It will open in your selected

browser. Click the buttons and amaze your

boss! Keep all the files in the folder intact,

and don’t be tempted to rename them.

FreeHand has a very specific way of creat-

ing the HTML files and doesn’t play nice – if

at all – when you tinker with them.

36. PDF exports are a pain!
Speaking from a Mac standpoint, don’t

use the obvious Export as PDF routine.

You’ll have one problem or another sooner

or later. Just give up and accept the most

common approach. Choose Print, then

change your printer selection to Adobe

PDF and choose Output Options. Put a

check mark in the Save As File box, and

then choose PostScript from the Format

drop-down menu. Please try to ignore the

PDF choice, and the large “Save As PDF”

button at the bottom. Now, choose

FreeHand MX from the main drop-down

menu and make sure that everything is in

order here – whether you want separations

or a composite print, printers' marks, col-

ors, page size, and so on. Then click Save. A

PostScript file will be created. When it’s

done, you must run the file through Adobe

Acrobat Distiller, and there you can select

the degree of quality for the file. Note that

you must have the “full” version of Adobe

Acrobat to have access to Distiller – but it’s

more than worth the investment cost.

37. Use a digital tablet.
If you’re a more traditional artist, you

will fall in love with a digital tablet. Some

have more features than others, and

costs vary from $50 to over $2,000, but

they’re priceless. Look for a review in an

upcoming issue of MXDJ.

38. Change the end points
of the Connector tool
arrows.

The Connector tool is great for organ-

ization charts and flow charts, but by
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Create vector shadows with blends.
To bypass the possible problems you may incur

with Raster Effects, create drop shadows the old fash-

ioned way  (see Figure 8). One way is to clone the

object that you want to have a shadow, and use

Modify>Combine>Union or Join if necessary to create

a single object. Then distort that object with an

Envelope or the 3D Rotation tool so that the object is

the shape of the outer edge of the shadow. Fill that

with the background color (subselect if necessary  to

do so) , and clone the object. Reshape/resize the form

directly beneath the original object, and give it the

darkest color the shadow should have. This could be a

gray, or a combination of the background color it com-

pliments. Then blend the two shadow objects.  It takes

very little time, and you don’t have to worry about res-

olution or RGB/CMYK conversion issues.
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default the arrows always go from the

center of the object’s bounding box.

Working with rectangles or ellipses does-

n’t present a problem, but other shapes

(stars, triangles and so on) are inconven-

ient. To trick the viewer, create a small

decoy – say a pixel or two square – with-

out a fill or stroke. Zoom in and place the

decoy above the target image, where you

want the arrowhead to point, or the con-

necting path to begin. Then use the

Connector point to create the path to the

decoy. If the path wants to select the tar-

get, hide it (View>Hide Object) until

you’ve made the Connector-connection.

39. Apply bitmaps on the
Perspective Grid.

Can’t do it, right? Instead, in FreeHand

import the image you want to have in per-

spective, and draw an outline of the image

(shown in red in Figure 10). Apply the out-

line to the Perspective grid, then copy that

path (Edit>Special>Copy Special) and

choose EPS for Photoshop 4/5 from the

menu. Then open a copy of the image in

Photoshop and Paste the outline as pixels

(on a new layer). Select the image layer

and choose Edit>Transform>Distort. Using

just the corner points, adjust the image to

fit the FreeHand path. Hide or delete the

FreeHand path, then save the image with

a clipping path, import it into FreeHand,

and place it on the grid.

40. Distort bitmaps with
the 3D Rotation tool.

Can’t do it, right? Heard that before?

You can proceed as described above, or

you can use the Trace tool to create a

vector drawing of the bitmap. Be mindful

that the more accurate the tracing is, the

more points and objects it has created.

You can make a tracing that is larger and

more complicated than the original

bitmap. But if you can use a minimum

number of colors, just trace the bitmap

and distort away with the 3D Rotation

tool, Fisheye Lens tool, Envelope tool,

and Perspective grid.

figure 10
figure 9

FFoorrttyy  TTiippss  aanndd

TTrriicckkss::  There are

dozens and

dozens of time-

saving things you

can do in

FreeHand. If you

want more, let us

know. For the time

being, run through

the FreeHand help

files and you’ll be

surprised at how

many things the

program can do

that you didn’t

even know about. 
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by kerry thompson

Don’t 

Squander 

Your 

Inheritance
Just get the job done – right

I 
Hi, my name is Kerry, 

and I’m a programmer.” 

looked around the room as people murmured 

“Hello, Kerry.” Most of them were what you would 

expect – some shaggy long hairs, a couple of women 

with buzz cuts, a pony tail here and there, some 

middle-aged guys with even less hair than I have. A lot 

of the people were generic American white, but there 

was a Chinese couple, a clean-cut man with a 

yarmulke, a couple of guys who looked Indian, and 

one lone, sad-looking black woman. Most of them 

tended toward middle age, probably because most of 

the youngsters are still out there chasing the next 

bug-fix high, or on deadline binges.

 “
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I took a deep breath and continued. “I’ve

done it all, pretty much. FORTRAN, COBOL,

Turbo Pascal, Assembler, RPG, Lingo,

JavaScript, XSLT, Lingo, ActionScript,

HTML…” People were nodding, thinking of

their own lost years. “Basic…” I could see a

couple of people purse their lips and shake

their heads, but I pushed ahead. I wanted to

come clean. “…and, in a lot of programs, I use

inheritance.”

There was a stunned silence. Apparently,

some things were too much, even for the

hard-core programmers here tonight. After a

moment, the moderator said, “Emm, yes,

inheritance.” I could hear the Dublin accent

in his voice. “Right, then.” He collected him-

self. “What drove you to that?”

I shrugged my shoulders. “I told myself it

was productivity. In truth, I think I had been

doing Lingo so long, I just didn’t get the rush

any more. So I had to do more programs. To

do more programs, I had to do OOP and,

inevitably, inheritance.”

One of the Indian guys spoke up. “Didn’t

your boss say anything?”

“I’m a freelancer. My clients never knew.

They just saw me whipping out the programs

in record time. They loved it, and never

asked. They became enablers, sending me

more and more work.” I paused. “And now I’m

here.”

The Backslider
After the meeting, as we were standing

around drinking caffeine-free cola, one of the

pony tails drifted over, looking a bit nervous.

“So, this inheritance stuff.” He glanced over

his shoulder and lowered his voice. “It really

works like they say?”

“Pretty much,” I said. “I thought it would

be hard, but once I started, well, it was like a

curtain parted and the secrets of the uni-

verse were revealed.” A bit of hyperbole,

maybe, but it’s hard to put a programming

high into words.

Pony Tail looked over his shoulder again,

and I could see a group of people watching

us. He leaned closer to me and whispered,

“I’ve got a laptop in the car.” He nodded at

the group. “Maybe you could show us some

of this inheritance stuff.” I must have looked

dubious, because he quickly added, “You

know, just so we’d know what it’s like.” I knew

I shouldn’t, but I nodded. Okay.

Pony Tail looked at the group, larger now,

jerked his head at the door, and started walk-

ing out. I followed, and, by ones and twos,

people from inside drifted out onto the side-

walk. Pony Tail disappeared into his car for a

moment, and then emerged with a Dell lap-

top. “Pentium,” he said proudly as he cracked

it open and the glow from the LCD lit the

faces around us. “Two-point-eight, a gig of

RAM, 80 gigs…”

“Hey, put that away!” We all looked at the

shaggy, bearish man who had spoken. He

glanced at the door to the room we had all

come from. The moderator was in earnest

conversation with one of the buzz-cut

women. As far as I could tell, the room was

empty except for them. It wouldn’t be long

before the moderator noticed the gaggle on

the sidewalk. “My place is just across the

street,”The Bear said urgently. “Dual proces-

sor G-5, Cinema display, XP 2004.”

The Bear’s Den
It took five minutes, but soon everybody

was crowded around the Bear’s computer.

Jolt Colas came out, and I could smell coffee

brewing as I fired up Director.

“Programming by difference,” I said,

somewhat self-importantly, but they were lis-

tening. I stuck a CD in the drive. “Not my

phrase. Irv Kalb taught me that.” A murmur

went through the room. Everybody had

heard of the legendary Irv Kalb, but no one

here except me had actually met him. “That

was Irv’s thinking when he used ancestors.

With a group of related objects, he’d build

one base class with all the common stuff,

and build separate objects that have the dif-

ferences.”

“You actually know Irv?” the Chinese man

asked. 

“Yeah, sure. Look, here’s a sprite manager

he wrote. I use it all the time.” I opened a

movie on the CD I had put in, double-clicked

a cast member, and the code appeared on

the screen (see Listing 1).

I heard a couple of soft whistles.

“Elegant,” somebody said. “I could use that in

my programs.” A pause, then the invietable.

“All of my programs!” A murmur of assent

went around the room as people realized the

implications of what I was showing them.

“Hold on,” I said. “We’re getting ahead of

ourselves. You have to use this stuff right, or

you can get in real trouble. Look – see that

icon? That means it’s a parent script. Ya gotta

do that.”

“Why?” somebody asked. “What happens

if you don’t?”

“No telling,” I shot back. “I know a guy

who spent three days trying to debug some

code. It turned out the code was okay, but he

had it in a movie script. Try to instantiate an

object from a movie script, boom! There goes

your schedule, your deadline, your bonus.”

People were nodding. They had all been

there, one way or another.

“Okay, basics,” I said. “I do a lot of educa-

tional stuff, so here’s one way I use inheri-

tance. Say I want to teach Spanish, or maybe

math, or reading. I’m going to have a lot of

activities – fill in the blank, drag-and-drop,

stuff like that.

“They’re all different activities, but they

all have a lot in common. I make them frame

scripts, so they all have to handle stepFrame,

and maybe begin-

Sprite and endSprite.” I started typing. “Here’s

the frame script for the first activity.”

property ancestor

on new me

ancestor = script ("Activity

parent").new()

“All you have to do is declare an ancestor

property, then assign a script to it. That makes

the ‘Activity parent’ script part of your object.

I’ll create that in a second, but first I’ll name

this one ‘Activity Script 1.’” I named it, used

the property inspector to make it a parent

script, and saved the movie (I do that a lot).

“Here’s the ancestor. It’s pretty simple.” I

clicked the ‘+’ on the script window to create

a new parent script, named it ‘Activity parent’,

and typed in a short handler.

on exitFrame

go the frame

end

“That’s the activity parent, the one you

declared in the activity script. I’ll name it

‘Activity parent’, since that’s what the activity

script is expecting to use as an ancestor.

“Now watch this.” I copied and pasted the

“Activity Script 1” cast member, and renamed

the copy to “Activity Script 2”. “Now you have

a start on two activities. They both use the

ancestor ‘Activity Parent’.”

“So, you’ve made two objects,” somebody

said from the back of the group. You’ve

saved, what, three lines of typing? What’s the

big deal?”

“Fair enough,” I said. “Only three lines. But

what if you have fifteen activities? You would

save nearly fifty lines of typing. Plus, you can

do this.” I opened the “Activity Parent” script

and changed it to this:
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on exitFrame

go the frame

end

on beginSprite

-- do your initialization here

end

on endSprite

-- do your cleanup here

end

“Imagine what it would be like if your

beginSprite and endSprite routines were 10

or 15 lines long. You would save a few hun-

dred lines of typing. For me, that’s a few hun-

dred lines of potential typos. Plus, you’d have

everything in one place for any changes.

“I know what’s coming next, too. What

if your activities have their own initializa-

tion and cleanup routines, and there are

differences from activity to activity?

“I go back to what Irv said – ‘program for

differences. ’Let’s change the activity par-

ent.” I hit the keyboard again, and a few sec-

onds later had Listing 2 in “Activity Script 1”.

“See, you can override the ancestor’s

methods. You can even override the

method, and still call the ancestor’s code.

That way you can do activity-specific stuff

in the activity code, and use the ances-

tor’s code for things that are common to

all the activities.

“Here’s another example. You want your

activities to handle and filter keystrokes. At

the same time, you want to have standard

keystrokes, stuff that doesn’t change from

activity to activity. Navigation, for example.

Let’s say you’re going to use a keystroke to

cycle through the activities – maybe F1.”

“That’s reserved. Brings up help.”

“Oh, yeah. Okay, how about Ctrl-F1?

Director doesn’t use that, does it?” Shrugs

and blank looks. Nobody knows all the

Director shortcuts. “We’ll try it.

“While we’re at it, we need a couple of activ-

ities that use different keystokes. Let’s make

Activity 1 a simple text editor, and in Activity 2

we’ll move a ball around the screen with arrow

keys. Simple stuff, but it’s good enough to give

you the idea. And anyway, we don’t want to be

here all night, do we?”I grinned. I knew most of

them would happily spend all night program-

ming. We’d gripe about it, but mostly for effect

(and to try to get a raise).

“So, we need to change the Activity

parents.” I brought up the code for activi-

ty 1 and made a few quick changes.

property pKeyHandler

property ancestor

on new me

ancestor = script ("Activity par-

ent").new()

pKeyHandler = script("Activity 1

Key Handler").new(me)

end

Similar changes went into the Activity 2

code. Then I clicked the  “+” sign again to cre-

ate a new script, and named it “Activity 1 Key

Handler”. This one took me a little longer, but

within a couple of minutes, with some help

from the group, I had the code in Listing 3.

I made a copy of the script and called

it “Activity 2 Key Handler”. I went in and

changed it to look for arrow keys:

on mDoKey me, keyID

case keyID of

28, 29, 30, 31: -- arrow keys

pOwnerActivity.mActOnKey(keyID)  

otherwise -- send the keyDown to

my ancestor.

ancestor.mDoKey(keyID)

end case

end 

“So, now we need to handle the keys in

the activities. I’ll just add Listing 4 to ‘Activity

Script 1’; and Listing 5 to ‘Activity Script 2’.

“You guys all know how to make a

text sprite and put it on screen, don’t

you?” Nods all around. “And a ball to

move around? I’ll leave the initialization

of those up to you.

That’s the activity-specific keys. Now we

just need to create a key handler parent to

handle Ctrl-F1. That’s a little more compli-

cated, but I have one on this CD here.” I

rummaged about in my collection of scripts

and found the one I was looking for. With a

few changes, we soon had a new script

called “Key Handler Parent”(see Listing 6).

“And  here’s a bonus – the ancestor

with the function keys defined, the ‘Key

Definitions’ ancestor used in the key han-

dler parent.” (See Listing 7.)

I swiveled around in the Bear’s Aeron

chair. “That’s about it. Any questions?”

There was a silence for a moment,

then, from the back of the group, “Can we

have a copy,” in our moderator’s unmis-

takable Dublin accent. Looking sheepish,

the Bear handed me a spindle of CD-

ROMs. I handed a printout to the group

and got to work on burning 20 CDs. 
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-- Sprite Manager by Irv Kalb

-- Copyright Furry Pants Productions

-- Used with permission of Irv Kalb, OOP expert

-- extraordinaire and author of LOOPE 

-- (Lingo Object Oriented Programming Environment) 

-- Visit him at www.furrypants.com

property plAllocation -- property which is a list of allocations

property pchLow -- channel of the first sprite to manage

property pchHigh -- channel of the last sprite to manage

on new me, chLow, chHigh

pchLow = chLow

pchHigh = chHigh

me.mInit()

return me

end

on mInit me

plAllocation = [:]

repeat with ch = pchLow to pchHigh

-- initialize all to FALSE (unallocated)

addProp(plAllocation, ch, FALSE) 

end repeat

end

on mAllocateChannel me

-- find the first empty channel

repeat with ch = pchLow to pchHigh

fAllocated = getAProp(plAllocation, ch)

if not(fAllocated) then -- found one

setProp(plAllocation, ch, TRUE) -- now mark it as allocated

return ch -- and return it to the user

end if

end repeat

alert("Attempting to allocate a channel, but there are none

left")

end

on mDeallocateChannel me, chToDeallocate

if (chToDeallocate < pchLow) or (chToDeallocate > pchHigh) then

alert("Trying to deallocate" && chToDeallocate && "but it is

not being managed.")

return

end if

fAllocated = getProp(plAllocation, chToDeallocate)

if not(fAllocated) then

alert("Trying to deallocate" && chToDeallocate && "but it has

not been allocated")

return

end if

-- set the allocation back to false 

setProp(plAllocation, chToDeallocate, FALSE) 

end

on mDebug me

put "Channel Allocation:"

repeat with ch = pchLow to pchHigh

fAllocated = getProp(plAllocation, ch)

if fAllocated then

put ch && ": Allocated"

else

put ch && ": Not allocated"

end if

end repeat

end

on mCleanup me

plAllocation = [:]

end

Listing 2

property ancestor

on new me

ancestor = script ("Activity parent").new()

end

on beginSprite

-- do your activity-specific initialization here

-- and call the same routine in the ancestor

call ancestor.beginSprite()

end

on endSprite

-- do your activity-specific cleanup here

-- and call the same routine in the ancestor

call ancestor.endSprite()

end

Listing 3

-- Activity 1 Key Handler

--***********************************************************

--* This object handles keystrokes for activity 1.

--* Any keys not specifically handled by the activity are

--* sent to the ancestor object.

--***********************************************************

property ancestor

property pOwnerActivity

on new me, ownerActivity

ancestor = script ("Key Handler Parent").new(ownerActivity, me)

pOwnerActivity = ownerActivity

return me

end

--* mDoKey gets the keystroke from the ancestor code

--* and processes keys specific to the activity. If

--* the key isn't used by the activity, the keystroke

--* is passed back to the ancestor for handling.

on mDoKey me, keyID

-- If the key is a backspace, valid English letter, numeral,  

-- or punctuation mark, act on it

if ((keyID > 31) and (keyID < 127)) or (keyID = 8) then

pOwnerActivity.mActOnKey(keyID)     

else -- send the keyDown to my ancestor.

ancestor.mDoKey(keyID)

end if

end 

Listing 4

property pTextMember

on mActOnKey me, whatKey

if (whatKey = 8) and pTextMember.text.length > 0 then

delete pTextMember.char[pTextMember.text.length]

else

if pTextMember.text.length = 0 then

put numToChar(whatKey) into pTextMember.char[1]

else

put numToChar(whatKey) after

pTextMember.char[pTextMember.text.length]

end if

end if

end
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Listing 5

property pBallSprite

on mActOnKey me, whatKey, cntlDown, cmdDown, optDown

case whatKey of

28: -- left arrow

if pBallSprite.locH > 16 then

pBallSprite.locH = pBallSprite.locH - 2

end if

29: -- right arrow

if pBallSprite.locH < 622 then

pBallSprite.locH = pBallSprite.locH + 2

end if

30: -- up arrow

if pBallSprite.locV > 18 then

pBallSprite.locV = pBallSprite.locV - 2

end if

31: -- down arrow

if pBallSprite.locV < 462 then

pBallSprite.locV = pBallSprite.locV + 2

end if

end case

end

Listing 6

-- Key Handler Parent

--*************************************************************

--*  This handles keystroke response that span activities.

--*

--*  Its descendant will be an activity key handler that handles

--*  activity-specific keystrokes

--* 

--*  This is a parent script that will be instantiated by the key

--*  handler for each activity.  It will check the keystoke and

--*  hand it off to its descendant. When the descendant has

--*  had a chance to process the key, it will then pass it 

--*  back to me.

--*************************************************************

property pKey

property pKeyCode

property ancestor

property pCntlDown

property pCmdDown

property pOptDown

property pOwnerActivity

property pMasterObject

property pDescendant

on new me, ownerActivity, descendant, masterObject

-- this ancestor contains key code definitions

ancestor = script ("Key Definitions").new(me)

pOwnerActivity = ownerActivity

pMasterObject = masterObject

pDescendant = descendant

return me

end

--*******************************************

-- process the key down event

--*******************************************

on keyDown me

pKey = chartonum(the key)

-- check for control keys, function keys, etc.

keyID = mDefineKey(me)

-- pass it to the descendant first

if objectP (pDescendant) then

pDescendant.mDoKey (keyID, pCntlDown, pCmdDown, pOptDown)

else

mDoKey

end if

end

--***************************************************

-- Do additional key definition here

-- This could be used to handle control, command,

-- or option/Alt key combinations

--***************************************************

on mDefineKey me

-- initialize properties in case the modifier keys are released 

-- before the key can be processed

pCntlDown = the controlDown

-- check for function keys

-- function keys have key codes between 96 (f5) and 122 (f1)

if (pKeyCode > 96) and (pKeyCode < 123)  then 

pKeyCode = pKeyCode + 256

return pKeyCode

else  

return pKey

end if

end

--***********************************************************

-- Here is where the parent handles the universal

-- keystrokes. In this example, for simplicity, it

-- only handles f1. In practice,

-- it could call special events for each key that it handles

--***********************************************************

on mDoKey me, keyID

if keyID = ancestor.pF1 then

-- a movie-level handler that switches activities

mSwitchActivities()

end if

end 

Listing 7

property pF1

property pF2

property pF3

property pF4

property pF5

property pF6

property pF7

property pF8

property pF9

property pF10

property pF11

property pHomeKey

property pEndKey

on new me

pF1 = 122 + 256

pF2 = 120 + 256

pF3 = 99 + 256

pF4 = 118 + 256

pF5 = 96 + 256

pF6 = 97 + 256

pF7 = 98  + 256

pF8 = 100  + 256

pF9 = 101 + 256

pF10 = 109 + 256

pF11 = 103 + 256

pHomeKey = 115 + 256

pEndKey = 119 + 256

return me

end
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nowboarding is all about individual style. And

whether your style delivers you to park or pow-

der, Series 13 (www.series13.com) from Burton makes sure

your board brings out the real you as you find your line.

Designed by Hanson Dodge Creative using Macromedia

MX Pro, Series 13 provides more than a million design

options to let riders create a unique, high-end signature

board. Through this Web-based tool on the Burton site,

riders can select the graphic artwork theme, finish, colors,

and base designs that let their own unique styles come

alive on the boards they ride.

Reaching New
Heights in 
Self-Expression

s






